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Chapter 1

Getting Started

Introduction

What is Tally?
Tally is a software application that reads, stores, and tabulates electronic Cast Vote Records (CVRs). 
More specifically, as part of the Hart Voting System, Tally tabulates CVRs from Mobile Ballot Boxes 
(MBBs) that have been generated by the Ballot Origination Software System (BOSS). MBBs contain 
Cast Vote Records from the eSlate, eScan, and/or Ballot Now paper ballots. MBBs also contain audit 
trail data that allows Tally to authenticate CVRs.

Tally is configured to tabulate specific election and contest data by creating a tabulation database based 
upon the BOSS database used to create the election. Tally databases may be configured in Test mode 
(to tabulate Test MBBs only) or in Election mode (to tabulate live election results). Tally counts and 
integrates vote totals for Absentee Voting (By Mail), Early Voting in person, and Election Day. Once 
CVRs have been read and tabulated, Tally can produce a variety of official reports and data exports in 
several formats, including PDF and XML. Tally operator actions are reported in a real-time audit log.

What is Rally?
Rally is a Hart Voting System software application that reads, stores and transfers Cast Vote Records 
from remote satellite stations to a Tally PC at the central counting station. Rally reads CVRs from voted 
Mobile Ballot Boxes, and transfers are initiated when the Tally PC contacts Rally stations via local area 
network (LAN) or modem connection. Although Rally is fully integrated with the Tally tabulation system, 
Rally does not tabulate; it reads CVR data and does provide for secure transfers, which are verifiable. 
Rally includes a real-time audit log and MBB processing reports.

This Document
This document is a training manual designed to guide operator training. It is meant for use in conjunction 
with the Tally Operations Manual, the Rally Training Manual, and the Rally Operations Manual. This 
training manual is intended for both initial training with Hart InterCivic Training Specialists, and as a 
reference to supplement the operations manuals once training is complete.

All steps that refer to a window, field, button, menu, or menu item on the display have the reference 
in bold (e.g., Save, Close, OK), unless referring to a table or list.
All steps that refer to a key on the keyboard have the key underlined (e.g., Ctrl, Shift, Enter).
The word “click” refers to a left click with the mouse unless otherwise stated.
All report titles are referred to in quotation marks, (e.g., “Ballot Content Proof”), unless referring to a 
table or list.

Refers to a cross-reference for more information regarding the topic.

Refers to a suggestion.

Refers to an advanced user tip.

Refers to a warning or caution.

  See:
  See:

  Note:

  Tip(s):
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Tally Operator Course Objectives

In the course associated with this document, you will:

Set up Tally databases for tabulation
Tabulate CVRs recorded on the MBBs directly into Tally
Conduct a system and embedded Logic and Accuracy Test (LAT)
Set up Tally and Rally PCs for communication
Transfer CVRs recorded on the MBBs to Tally via Rally
Resolve Early Voting retrievable ballots
Resolve provisional ballots
Resolve write-in votes for candidates
Adjust votes as appropriate
Generate unofficial and official reports
Finalize databases
Back up, delete, and restore Tally databases

  See:
  See:“Hart Voting System Security Features” on page 4.
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Hart Voting System Data Flowchart
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Hart Voting System Security Features
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Tally Windows
• About Tally window 

showing the application 
version information

• If the Release number 
does not match your 
state-certified version, 
contact Hart InterCivic 
immediately.

• If the words “Not 
Certified” display, 
contact Hart InterCivic 
immediately. 
 

Tally window, Election 
Databases tab

• Tally title bar
• Menu bar
• Quick Links (tabs)
• Active panel title 

(active tab)

• Tally database list

• Details about currently 
highlighted database

• Available actions

• Current User
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Tally window, Election 
Information tab

• Tally title bar displaying 
selected database 
description

• Information on ballots, 
MBBs, precincts, and 
totals

• Quick Links are 
available because 
tabulation is stopped

 

• Available actions
• Rally station status
• Status bar showing 

Tally connection status 
(task bar not available)
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Tally Menus
These menus are available in the Tally Menu Bar. The availability of menu items is dictated by user 
permission settings. A brief explanation of each menu item follows:

File Menu
• Import Tally databases
• Export vote totals
• Exit the application

View Menu

Provides alternative access to 
available Quick Links

• Go to Election Databases
• Go to Election Information
• Go to Reporting
• Go to Write-In Resolution
• Go to Provisional Ballots
• Go to Retrievable Ballots

Options Menu
• Configure processing of 

provisional ballots and split 
precincts before processing MBBs

• Mark reports “Official” and select 
write-in vote Reporting Options

• Change the ballot source labels 
that appear on reports

• Configure transfer settings for 
Rally stations

• Configure user permissions
• Configure real-time audit printer 

settings
• Calculate manual Vote 

Adjustments

Help Menu
• Access information about the Tally 

application version
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Maximum Number of Characters for Fields in Tally
The following table lists the maximum number of characters allowed in Tally window and tab data entry 
fields (organized alphabetically by window or tab, then field):

Window or Tab Field Maximum Characters

Add Write-In Candidate Aliases-Add 100

Add Write-In Candidate Candidate Name 100

Certificate Name 64

Certificate Organization 64

Certificate City 100

Certificate State 100

Custom Report Wizard Report Name 70

Custom Report Wizard Report Title 100

Database Wizard Database Description 100

Export Wizard Export File Name 70

Import Wizard District Name 100

Import Wizard Name of File to Import 90

Landscape Export File Name 50

Rally Configuration IP Address 15

Rally Configuration Phone Number 14

Rally Configuration Rally Station Name 40

Rally Configuration User ID 12 (min. 6)

Rally Configuration Password 12 (min. 6)

User Configuration User ID 12 (min. 6)

User Configuration Password 12 (min. 6)
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Tally Database Management
Tally database management includes naming the database with a convention that is user friendly; 
keeping track of database status and mode; testing; and noting the database file path for CD backup.

Database Naming Conventions

Use a consistent naming convention. Suggested convention:

Function of the Database

Describe the function of this database. The database may be a test, a live election, a recount, or a Tally 
database set up for training purposes. “Test” and “Election” are also database modes, but including this 
in the description name is helpful to the user. The “Function of the Database” wording should be entered 
in ALL CAPS to help with database identification.

Sequence Number

This signifies the number of times this database, for this function, has been brought into Tally.

Election Description

Describe the election event with, at minimum, the election title or the database description from BOSS 
and the date (Election Day date). Tally’s Database Wizard autofills the Enter a description for the 
Database field with the Election Title field data from BOSS.

Database Status

  Note:
Only one New or Opened Election mode database, from the same finalized BOSS database, can 
exist in the same Tally application at one time. After finalizing an Election mode database, 
another Election mode database may be initialized in Tally.

Function of the Database Sequence Number Election Description

TEST TRAINING 4 General Election 11.05.02

TEST 1 Community Election 5.03.03

ELECTION 1 Community Election 5.03.03

RECOUNT 2 Community Election 5.03.03

Status Availability

New In this state, the database has no votes recorded yet (no MBBs from Test 
or Election have been tabulated), and it is available to process MBBs.

Opened In this state, the database has votes recorded in it and is available to 
continue processing MBBs.

Finalized In this state, the database is not available to process MBBs. All MBBs for 
the election have been read. The database is available for reporting, 
write-in, retrievable, and provisional ballot resolution, vote adjustments, 
and exporting, but not for processing MBBs.
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Database Mode

  Note:
Test and Election mode databases from the same finalized BOSS database can exist 
simultaneously, in any state, in the same Tally application. Test and Election databases from the 
same finalized BOSS database are completely separate.

Testing

A Logic and Accuracy Test (LAT) is a test of the accuracy of the tabulation system compared to the input 
on the voting device. Logic and accuracy testing should take place before going live with an election, 
including Absentee and Early voting in-person. Follow federal, state, and local guidelines for logic and 
accuracy testing. Logic and accuracy testing is done from the BOSS ELECTION database that will be 
used for the live election and the Tally TEST database.

  See:
  See:“Logic and Accuracy Testing Procedures” on page 37.

Database File Path

The database file path records the directory for the TallyData.db database and TallyData.cfg files. All 
Tally databases include these files in a numbered folder that is unique to that database. When creating a 
new Tally database from a finalized BOSS database, the Tally application copies the BossData.db file 
from the finalized BOSS database and converts that file to a TallyData.db file. For each new Tally 
Election database created, a new folder for the TallyData.db and TallyData.cfg files is automatically 
created on the computer hard drive in the path C:\Program Files\HartInterCivic\Tally\Database. The Tally 
database folder itself is named according to the Year, Month, Day – Hour, Minute, Second (24-hour 
clock) that the database was created. For example, database folder “050118-144135” was created on 
January 18, 2005 at 2:41:35 p.m. 

Mode: Availability:

Test Tally will only read and tabulate Test mode MBBs. Test mode is employed for Logic 
and Accuracy testing. Multiple New, Opened, or Finalized Test mode databases, 
from the same finalized BOSS database, can exist simultaneously.

Election Tally will only read and tabulate Election mode MBBs. Only one New or Opened 
Election mode database, from the same finalized BOSS database, can exist in the 
same Tally application at one time. Election mode is employed for “live” election 
data.
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Backing up a Tally Database

Back up by navigating to the Tally database folder and copying the entire folder to CD, or by using the 
Backup function in Tally. The Backup function saves the original Tally database file (TallyData.db)  and 
configuration file (TallyData.cfg) to a new location. Hart InterCivic recommends that Tally databases be 
backed up frequently during live election tabulation. For advanced users, a backed-up database can 
also be restored to a previous condition and/or state. 

Back up the numbered Tally database folder (or use the Backup function in Tally):
After each instance of creating printed and exported reports for public use (e.g., media outlets)
After processing absentee by-mail MBBs on Election Day
After processing Early Voting MBBs
After each instance of creating printed and exported reports for public use (e.g., media outlets) on 
Election Day
After processing absentee by-mail late mail MBBs after Election Day
Before resolving write-in votes
Before resolving provisional ballots
Before finalizing
After finalizing
Immediately after Canvassing

  See:
  See:“Appendix D: Backing Up Election Databases” on page 115.

“Appendix H: Restoring a Tally Database to a Previous State” on page 153.

Deleting a Tally Database

Once an election is completed, the appropriate (federally or locally mandated) waiting period has 
passed, and the Tally database has been backed up, you may delete election databases in order to save 
hard drive space on the PC. You may also delete Tally databases that were used for practice purposes. 

To delete a Tally database, take note of the database file path in the Election Databases panel of the 
Tally window, and click the Delete button to delete the database from the window. If deleting Tally 
databases with the “New” status, Tally may direct you to exit Tally, navigate to the folder indicated in the 
database file path, and delete the database folder.

Rally Database Management
Each Rally PC has one Rally database folder located at “C:\Program Files\Hart 
InterCivic\Rally\Database”. All data run on each Rally PC saves to this folder. There is one Rally 
database named “Mbbtrans.db”. Rally saves all data to this database. Back up the Rally database folder  
to CD in a folder named and dated for the election after each election in which Rally is used. 

After the database folder is backed up, reset the database in the “Rally\Database” folder to a blank state. 
In Rally, go to the Database menu and click Reset. Resetting the database folder also resets the Rally 
station name to prepare for the next election.

Back up each Rally station “Database” folder (or use the Archive function in Rally):
After processing all MBBs, and printing and exporting final reports
Before resetting the Rally database (including before resetting the Rally database as an emergency 
procedure)

  See:
  See:“Appendix D: Backing Up Election Databases” on page 115.
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Tally Overview

Tally Install Settings

When Tally is installed the following settings must be established as appropriate for adherence to 
federal, state, and local guidelines. These settings will be selected by Hart InterCivic, based on client 

choices.1

1. Select Retrievable Ballot 
Interface if Early Voting 
ballots will be retrievable by 
Ballot Code. 

2. Select Provisional Ballot 
Parsing Interface if 
provisional ballots may be 
reassigned in order to report 
only contests available in 
provisional voters’ actual 
precinct (the precinct of 
residence).

  See:
  See:“Provisional Parsing” on 

page 106.

3. If the Provisional Ballot 
Parsing option was 
selected, the next 
InstallShield Wizard window 
prompts the installer for the 
destination of parsed 
provisional ballots for 
reporting purposes. Parsed 
provisionals can report to 
either the precinct of 
origination or to the 
reassigned precinct (the 
precinct of residence).

1. Some Tally application operations described in this document and the Tally Operations Manual are affected by these settings.
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Pre-Tally Activities

Before copying the BOSS database into Tally:

1. Create the ballot in BOSS.
2. Write all MBB and DAU cards.
3. Back up the BOSS database.
4. Finalize the BOSS database for Tally.
5. Back up the BOSS database.
6. With MBBs created in BOSS:

a.  Conduct a Test and/or Election mode election with eSlates and/or eScans.
b. Scan and save cast vote records for voted Ballot Now paper ballots in Test and/or Election 

mode, if applicable.

Pre-Election Day Activities

Before Election Day, perform the following tasks with the Test and/or Election mode Tally databases that 
have the NEW or OPENED status:

1. Define Tally options for reporting and consolidating split precincts in both the Test and Election 
mode databases.

2. Define Tally options for reporting unresolved write-in votes. If the eScan is being used, and the 
ballot includes write-in candidates, unresolved write-ins should be set to report as a separate 
category.

3. If write-in candidates and aliases are known, define eligible write-in candidate names in both the 
Test and Election mode databases.

4. Set ballot source labels for reporting, if the ballot sources are named something different from 
Early, Absentee, and Election.

5. Print a Tally Zero Report for a Test mode database.
6. Vote the Test MBBs.
7. Read the Test MBBs into a Test mode database as part of a logic and accuracy test.
8. Finalize a Test mode database.
9. View and print Test Tally reports.
10. Define Tally’s Rally Configuration, if applicable.
11. (Optional) Set up Rally stations and test data transmission from Rally stations into a New Test 

mode Tally database.
12. Reset Rally station databases after testing, and verify Rally station names by clicking the 

Options Quick Link and clicking Station tab, if applicable.
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Election Day Activities
On Election Day perform the following tasks with the Tally Election mode database that has the NEW or 
OPENED status:

1. Print a Tally Zero Report.
2. Read election MBBs from:

2.1  Absentee ballots recorded with the Ballot Now application
2.2  Early Voting ballots
2.3  Election Day ballots
2.4  Rally stations
2.5  Spare MBBs not used in the election

3. Manage Early Voting retrievable ballots, if applicable.
4. Manage provisional ballots.
5. Add write-in candidates and aliases and assign write-in votes.
6. View and print unofficial and official Tally reports.

7. Adjust votes manually.2

8. Export vote totals.
9. Back up the Tally database often.

Post-Election Day Activities

After all MBBs for the election have been read, perform the following tasks with the Tally Election 
database:

1. Back up the Tally database.
2. Finalize the database.
3. Manage Early Voting retrievable ballots, if applicable.
4. Manage provisional ballots.
5. Add write-in candidates and aliases and assign write-in votes.
6. View and print unofficial and official Tally reports.
7. Adjust votes manually.
8. Export vote totals.
9. Back up the Tally database.

  See:
  See:“Appendix D: Backing Up Election Databases” on page 115 for recommendations on database 

archiving.

2. The Tally application allows the user to manually adjust the vote totals for a contest. This feature is used to record votes from 
another vendor’s equipment, or to adjust vote totals for abnormal conditions (e.g., late mail that was not processed with Ballot 
Now).
The user must select the precinct/split and ballot source (Absentee/Early/Election) that is to be adjusted. The change in ballot 
count will be displayed to the user. The ballot count for the precinct/split will be adjusted to be equal to the largest ballot count for 
any contest contained in that precinct/split; therefore, undervotes and overvotes, if applicable, must also be accounted for. If 
vote adjustment causes a change in ballot count in a precinct, this change will be reflected on total ballots reported for the 
election.
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Tally User Permissions and Certificate

First Login After Installation of Tally

Complete the following steps at the first startup of Tally after installation. If Hart InterCivic has already 
completed them during installation and testing, then create local users and permissions and delete those 
users added during installation and testing.

1. Start Tally from either the desktop shortcut or the Start 
button on the Windows taskbar. 

2. In the User ID field, enter a User ID for a user who will have 
Administrator permissions in Tally. The field limit is 6-12 
characters.

3. In the Password and Confirm Password fields, enter the 
password for the administrator-level user. The field limit is 
6-12 characters, case sensitive. 

4. Click OK and the Certificate window appears.
5. Complete the certificate and click OK. The certificate is used to verify a trusted connection (as 

with a Tally-Rally connection). Enter a unique password or an administrator-level User ID in the 
certificate Name field. Log certificate information.

Creating Additional Users

1. Go to the Options menu and click User Configuration. 
2. Enter User ID, password, and password confirmation. 

Select the user permission setting and click Add. The User 
ID field limit is 6-12 characters. The password field limit is 
6-12 characters. The password field is case sensitive.

Updating Certificate Information

1. Go to the Options menu and click Transfer 
Configuration.

2. On the Basic Setup tab of the Rally Configuration 
window, click the Certificate button.

3. In the Certificate window, update the target fields and click OK.
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Tally User Permissions

Tally Function: Administrator: Operator: Database State:

Database Management
Create Database Yes No
Delete Database Yes No New, Open, 

Finalized
Import Database Yes No
Select Database Yes Yes New, Open, 

Finalized
Back up Database Yes Yes New, Open, 

Finalized
Restore Database Yes Yes New, Open, 

Finalized
Finalize Database Yes No New, Open
MBB Processing
Read MBB Yes Yes New, Open
Tabulate MBB Yes Yes Open
Rally Station
Rally Configuration Yes Yes New, Open
Rally Communications Yes Yes New, Open
Reports
Execute Reports Yes Yes New, Open, 

Finalized
Create Custom Reports Yes No New, Open, 

Finalized
Delete Custom Reports Yes No New, Open, 

Finalized
Write-in Features
Write-in Resolution Yes No New, Open, 

Finalized
Write-in Option Configuration Yes No New, Open, 

Finalized
Other Functions
Manual Vote Adjustment Yes No Open, Finalized
Provisional Ballot Resolution Yes No Open, Finalized
Tally Import Yes No Open, Finalized
Tally Export Yes Yes New, Open, 

Finalized
User Configuration Yes No New, Open, 

Finalized
Application Configuration Yes No New, Open, 

Finalized
Certificate Yes Yes New, Open, 

Finalized
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Setting Up Tally’s Real-Time Audit Log
The Tally real-time audit log lists all auditable events performed in Tally since the Tally installation. There 
is no header, title, column heading, or footer information in the real-time audit log. 

To view the real-time Tally log, first establish the correct audit printer settings. Go to the Options menu 
and click Audit Printing. View the real-time audit logs in one of two ways:

1. Connect a line printer to an LPT port on the PC. Do not install printer drivers. Start Tally. Go to the 
Options menu, click Audit Printing, and select the LPT port to which the printer is connected. 
Exit Tally. Log in to Tally. The line printer will print a record of each action taken in a Tally session. 
Printer errors, or not powering on the printer, will cause an error message to display and ONLY 
access to the line printer settings will be allowed in Tally.

2. OR Start Tally. Go to the Options menu, click Audit Printing, and select the audit printer setting 
FILE. A real-time audit printer file, named “FILE”, will be saved to the directory C:\Program 
Files\Hart InterCivic\Tally. This file will contain a record of each action taken in a Tally session. To 
view this file, copy it to an election-specific folder and add the extension “.txt” to it. If using this 
option, make certain to retain this file as a part of the election records. 
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Tally Tasks Requiring the eSlate Cryptographic Module (eCM)

What is the eCM?

The eCM is a physical USB security device provided by Hart InterCivic. It is required for access to 
secure functions in the BOSS, Ballot Now, Tally, Rally, and SERVO applications. The eCM must be 
generated using the eCM Manager application.

When is the eCM Used?

In a given election, the signing key on the eCM is used by the BOSS application to accept the ballot 
formats for the election, and a matching signing key must also be present in the eCM(s) used in the 
Ballot Now, Tally, Rally, and SERVO applications. 

The simplest way to use an eCM is to keep the device handy (e.g., on a lanyard on your person) and to 
insert the eCM token into a USB port on an election PC each time that PC is being used, removing the 
eCM when finished. In Tally, the eCM is inserted into a USB port on the tabulation PC.

When the eCM is accessed, Tally requires the operator to enter the eCM PIN (a password selected by a 
jurisdiction administrator before any signing keys are generated).

In Tally, the eCM is used to read the first MBB during a Tally session. If you log out of Tally, the session is 
over. When you log in to Tally again, you must re-enter the eCM PIN with the eCM token inserted in 
order to continue reading MBBs.

eCM Management

The eCMs should be closely managed. The number of eCMs being used for an election and their PIN(s) 
should be logged in a secure location. eCMs should be labeled with the election name or similar 
information, but not with the eCM Key ID or PIN. eCMs should be stored in a secure location, separate 
from election MBBs.
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Notes:
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Notes:
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Chapter 2

Using Tally to Count Voted MBBs

These procedures outline the steps for tabulating an election with the Tally application alone (i.e., without 
Tally-Rally communications).

Steps: Details:

1. In the BOSS program, finalize the BOSS 
database for Tally.

Make sure you have written all MBBs and 
DAU cards before finalizing the BOSS 
database.

After finalizing, you cannot write additional 
cards.

2. Double-click the Tally desktop shortcut to 
open the application.

3. Log in to Tally as a user with Administrator 
permissions.

4. If you haven’t already done so, set up 
Tally users and permission levels.

Go to the Options menu and click User 
Configuration.

  See:
  See:“Tally User Permissions and Certificate” 

on page 15.
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5. Create and name/describe a new Test or 
Election mode database in Tally by 
copying the finalized BOSS database or 
importing an existing Tally database from 
file.

Click the Election Databases Quick Link and 
click New to bring in a finalized BOSS 
database, or click Import to import an existing 
Tally database from file.
With the Database Wizard, set the Tally 
database configurations for split precincts, 
reporting display, and tabulation processing.
Set Database Configuration when creating 
the database, or after opening the database 
and before reading MBBs by going to the 
Options menu and clicking Database 
Configuration.
Test mode and Election mode databases are 
created in Tally separately.
Each Tally database must have a unique 
name/description.
Only one Tally Election mode database for a 
specific BOSS database may exist in a NEW 
or OPENED state at a time.

  See:
  See:Suggested naming conventions in “Tally 

Database Management” on page 9.

6. Highlight the target database and click 
Select to open it.

Steps: Details:
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7. Set the Tally reporting options for report 
labeling, candidate cross-filing, and write-
in reporting.

Go to the Options menu and click Reporting 
Options.

8. (Optional) Change the ballot source labels 
that appear on reports.

Go to the Options menu and click Label 
Options.

9. (Optional) Define qualified write-in 
candidates and aliases, if applicable.

To define write-in candidates before reading 
MBBs, click the Write-In Resolution Quick 
Link.

  Note:
Write-in candidates and aliases can be 
defined before and/or after MBBs are 
read. Write-in votes matching a candidate 
or alias name will automatically assign to 
that candidate.

  Tip(s):
Defining candidates AFTER reading 
MBBs may be a more efficient process 
unless all write-in candidates and aliases 
are known before tabulation.

Steps: Details:
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10. Create a Tally “Zero Report”. Click the Reporting Quick Link and select the 
“Cumulative Report” before reading any MBBs 
into Tally.

Steps: Details:
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10.1  Select report options available, click 
OK, and view the report.

Print hard copy.
Export to file in an available soft copy format 
via the report export tool.

  Note:
Report options available will vary per 
report type and election type. The 
graphics at left show the “Cumulative 
Report” options for a general election 
(top) and primary election (bottom).

11. If you haven’t already done so, insert the 
eCM into a USB port.

The eCM can be removed from the USB port 
after the first MBB for the session has been 
read into Tally.
Store the eCM in a secure location.
The simplest way to use an eCM is to keep 
the device handy (e.g., on a lanyard on your 
person) and to insert the eCM into a USB port 
on an election PC each time that PC is being 
used, removing the eCM when finished.

Steps: Details:
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12. Process MBBs. Click the Election Information Quick Link.
After the first MBB for the session is inserted 
into the card reader, the Tally application will 
prompt the operator to enter the eCM PIN.

Tally automatically reads subsequent MBBs 
after they are inserted into the card reader. 
To tabulate, select the Start button in the 
Election Information panel of the Tally 
window. The Start button may be selected 
while reading MBBs.
For a Logic & Accuracy Test (LAT), process 
Test mode MBBs in a Test mode Tally 
database.

  See:
  See:“Logic and Accuracy Testing Procedures” 

on page 37.

  Note:
You must stop tabulation in order to use 
the other Quick Links.

13. Print reports. Stop tabulation.
Click the Reporting Quick Link.
Print hard copies of desired reports.
Export soft copies of desired reports in 
available formats via the report export tool.

Steps: Details:
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14. For risk-reduction and archival purposes, 
back up the Tally database to a time-
stamped folder.

Click the Election Information Quick Link.
The Backup button in the Election 
Information window will back up the original 
TallyData.db and TallyData.cfg files to another 
location on the PC hard drive. 
The file path to the Tally database folder 
(identified in the Election Databases panel of 
the Tally window) is:
C:\Program Files\Hart InterCivic\Tally
\Database\YearMonthDay-
HourMinuteSecond (YYMMDD-HHMMSS).

  See:
  See:“Appendix D: Backing Up Election 

Databases” on page 115.

15. Process Early Voting Retrievable ballots, 
if applicable.

            OR Import retrievable data.

  See:
  See:“Tally Install Settings” on page 12.

“Appendix I: Importing Data” on page 155.

Click the Retrievable Ballots Quick Link.
• Select a column heading to sort on that 

column.
• Right-click a Status cell in order to 

change a single ballot’s status.

• OR Use Ctrl-click or Shift-click to select 
several rows, then right-click to change 
the status of multiple ballots.

• Select the Confirm box for each ballot for 
which the status has been verified and 
print the “Retrievable Ballot” report.

Early Voting Retrievable resolution is also 
available after finalizing the database.

Steps: Details:
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16. Include or confirm exclusion of provisional 
ballots, if applicable.

            OR Import provisional data.

  See:
  See:“Tally Install Settings” on page 12.

“Appendix I: Importing Data” on page 155.

Click the Provisional Ballots Quick Link.
• Select a column heading to sort on that 

column.
• Click a Status cell in order to change a 

single ballot’s status.

• OR Use Ctrl-click or Shift-click to select 
several rows, then right-click to change 
the status of multiple ballots.

• Select the Confirm box for each ballot for 
which the status has been verified.

Provisional ballot resolution is also available 
after finalizing the database.

17. Parse provisional ballots, if applicable.

            OR Import provisional data.

  See:
  See:“Tally Install Settings” on page 12.

“Appendix I: Importing Data” on page 155.

Provisional parsing modifies the tabulation of 
the provisional ballot so that only those 
contests on the voter’s true voting precinct 
ballot will be reported.
During Tally installation, settings are selected 
enabling parsed ballots to report to either the 
original (voted) precinct or the reassigned 
(true) precinct.

  See:
  See:“Tally Install Settings” on page 12.

To parse a ballot:
• Select the precinct cell for the target 

ballot.
• Click the drop-down arrow to select the 

target precinct to reassign the ballot to.
• Select the Confirm box for each ballot for 

which the status has been finalized.
Provisional parsing is also available after 
finalizing the database.

18. Print the “Ballot Status” report for 
provisional ballots, if applicable.

Click the Reporting tab and double-click 
Ballot Status in the list of reports.
In the Ballot Status field, select Included.
In the Ballot Type field, select Provisional.
Click OK and print the report.

Steps: Details:
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19. Resolve votes for write-in candidates, if 
applicable.

19.1  Resolve write-in votes from the eSlate 
and Ballot Now.

Click the Write-In Resolution Quick Link.
• Add qualified write-in candidates and 

aliases. 
> To add candidates after reading cards,  

highlight and click the full and correct 
spelling of the candidate name in the 
Unresolved Write-in Votes panel.  
In the Add Write-In Candidate 
window, click the Add button, and 
then click the Save button to move the 
candidate over to the Candidates/
Aliases panel.

> If there is a blank entry in the 
Unresolved Write-In Votes panel, 
then a voter has selected a write-in 
option, but entered no data.

• To assign unresolved votes to candidates, 
select the target candidate in the 
Candidates/Aliases panel, select the 
target alias name in the Unresolved 
Write-in Votes panel, and select the 
uppermost left-pointing arrow.

• To reject unresolved votes, select the 
target name in the Unresolved Write-in 
Votes panel and select the lower left-
pointing arrow to assign these to the 
Rejected Write-in Votes panel.
> Use Ctrl-click and Shift-click to make 

multiple selections.
You can also resolve write-in candidates after 
finalizing the database.

Steps: Details:
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19.2  Resolve write-in images and votes 
from the eScan.

Before Write-In Resolution

After Write-In Resolution

Click the Write-In Resolution Quick Link.
• Resolve write-in images so Tally can 

recognize them. 
> Select a contest with write-ins and 

select the Resolve Images button.
> Enter the name of the write-in 

candidate in the Enter Write-in Data 
field of the WriteIn Image Resolving 
- <contest name> window and select 
the Assign button.

> OR Select the name from the WriteIn 
Data Selection List.

> Select the Close button in the WriteIn 
Image Resolving - <contest name> 
window. The name is added to the 
contest’s Unresolved Write-In Votes 
list.

• Resolve write-in votes using the same 
resolution process as eSlate and Ballot 
Now.
> Add qualified write-in candidates and 

aliases.
> Assign unresolved votes to 

candidates.
> Reject unresolved votes.

  See:
  See:See step 19.1  on page 29 for more 

detailed instructions on resolving write-in 
votes.

Steps: Details:
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20. Calculate vote adjustments, if applicable. Go to the Options menu and click Vote 
Adjustments.
• Select the precinct (and split, if 

applicable).
• If adjusting votes for a primary election, 

select the party.
• Select the ballot source (Early Voting, 

Absentee, or Election Day).
• For each contest on a ballot, enter the 

adjustment to the appropriate option by 
selecting the corresponding item in the 
Adjustment column.
> Enter adjustments for overvoted and 

undervoted contests, in addition to 
properly marked ones. 

  Tip(s):
Think of manual vote adjustments as 
being made per ballot.

The number of ballots voted is calculated 
based on the maximum number of votes 
for any one contest in a precinct/split. For 
this reason, it is important that overvotes 
(e.g., for paper ballot adjustments) and 
undervotes be accurately registered.

You can also adjust votes after finalizing the 
database.

21. For risk-reduction and archival purposes, 
back up the Tally database to a time-
stamped folder before finalizing.

Click the Election Information Quick Link.
The Backup button in the Election 
Information window will back up the original 
TallyData.db and TallyData.cfg files to another 
location on the PC hard drive.
The file path to the Tally database folder 
(identified in the Election Databases panel of 
the Tally window) is:
C:\Program Files\Hart InterCivic\Tally
\Database\YearMonthDay-
HourMinuteSecond (YYMMDD-HHMMSS).

  See:
  See:“Appendix D: Backing Up Election 

Databases” on page 115.

Steps: Details:
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22. After all MBBs have been processed, 
finalize the election in Tally.

Before finalizing, read spare MBBs that were 
not used in the election in order to account for 
all MBBs.
You can finalize the database before 
processing Early Voting retrievable ballots, 
provisional ballots, write-ins, or vote 
adjustments.
To finalize, click the Election Information 
Quick Link and click the Finalize button.

23. Print standard reports. After finalizing, report labels default to 
“Official”. To change labeling to “Unofficial”, 
go to the Options menu and select 
Reporting Options. 
Print hard copies of desired reports.
Export soft copies of desired reports in 
available formats via the report export tool.

Steps: Details:



6300-005 62C Tally Training Manual

© Hart InterCivic, Inc. Chapter 2 Using Tally to Count Voted MBBs Page 33

24. Create and print Custom Reports by 
clicking the Tally Report Wizard button 
in the Reporting window.

Create and print district reports with the 
Custom Report Wizard.
A. Enter a unique Report Name that will 

appear in the Tally reports list.
B. Select a Base Report using the drop-

down arrow.
C. Enter a unique Report Title to appear at 

the top of the report.
D. Select Next and follow prompts.

> In the Precinct Filter step, choose the 
desired district from the drop-down list 
and all associated precincts will be 
selected for the report, or create a 
new set of precincts.

If a previously undefined district is needed for 
reports, go to the File menu and click Import 
to import a .csv or .txt district definition file.

  See:
  See:“Appendix I: Importing Data” on page 155.

25. For risk-reduction and archival purposes, 
back up the Tally database to a time-
stamped folder.

Click the Election Information Quick Link.
The Backup button in the Election 
Information window will back up the original 
TallyData.db and TallyData.cfg files to another 
location on the PC hard drive. 
The file path to the Tally database folder 
(identified in the Election Databases panel of 
the Tally window) is:
C:\Program Files\Hart InterCivic\Tally
\Database\YearMonthDay-
HourMinuteSecond (YYMMDD-HHMMSS).

  See:
  See:“Appendix D: Backing Up Election 

Databases” on page 115.

Steps: Details:
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26. Import data, if necessary. Go to the File menu and click Import to 
import files via the Tally Import Wizard.
Importing data may be performed at any time.
Import types include:
• District Definition - to update precinct/

district associations
• Provisional Ballot Status - to update 

include/exclude status and parsing of 
provisional ballots

• Registered Voters - to update the number 
of registered voters per precinct as 
defined in BOSS

• Retrievable Ballot Status - to update 
include/exclude status of retrievable 
ballots.

  Tip(s):
Import files may originate from a Voter 
Registration system. 

  See:
  See:“Appendix I: Importing Data” on page 155.

27. If data was imported, repeat reporting and 
database backup steps.

  See:
  See:“Appendix D: Backing Up Election 

Databases” on page 115.

Steps: Details:
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28. Export data, if necessary. Go to the File menu and click Export to 
export files via the Tally Export Wizard.
Exporting data may be performed at any time.
Export types include:
• Landscape Vote Totals - aggregated vote 

totals in a landscape .txt format
• EDX - Election Data eXchange XML 

format for integration with other systems
• Detail Vote Totals - filtered for Absentee, 

Early Voting, and/or Election Day results 
in .txt format

• Provisional Ballot Status - codes included/
accepted and excluded/rejected in .txt 
format

• Retrievable Ballot Status - codes 
included/accepted and excluded/rejected 
in .txt format

• Registered Voters - registered voter data 
in .csv format

  Note:
When creating Registered Voters export 
files for primary elections, select the 
Export By Party checkbox so the vote 
totals can be re-imported.

Also export reports with the Export tool 
available in each Tally report toolbar.

  See:
  See:“Appendix J: Exporting Data” on 

page 163.

29. Exit Tally. Go to the File menu and click Exit.

Steps: Details:
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Notes:
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Chapter 3

Logic and Accuracy Testing Procedures

A Logic and Accuracy test (LAT) is a test of the current election database on the Hart Voting System. It is 
a test of the logic of tabulation; a vote for any option must tabulate to that option. It is not a functionality 
test.

The timeframe for performing LATs is dictated by state and local guidelines. These tests cannot be 
performed until the BOSS database is finalized. You should perform system LATs before issuing live 
Election mode ballots.

This chapter describes two forms of LATs:

1. A system LAT, testing the logic of the tabulation system-wide. This LAT includes voting on 
devices, running device reports, tabulating the vote count in Tally, and comparing device records, 
Tally application reports, and expected outcomes.
> The complete LAT should be performed with Test mode MBBs.
> Only Test mode ballots can be used when performing the complete LAT.
> The complete LAT is run identically to a live election, from the same BOSS database; 

however, Ballot Now and Tally Test mode databases are segregated from Election mode 
databases.

> The LAT is usually performed in Early Voting mode on the voting devices. This allows for all 
precincts/ballot styles to be available for testing using a minimal amount of equipment. 

2. An embedded LAT on the eScan devices. This LAT includes voting on devices and running 
device reports, and then comparing device records to expected outcomes.
> The embedded LAT can be performed with Test or Election mode MBBs.
> Only Test mode ballots can be used when performing the eScan embedded LAT.
> The embedded LAT does not save Cast Vote Records and cannot be taken to Tally. 
> The embedded LAT does print a device results report, which can be compared to expected 

outcomes.
> The embedded LAT functionality is available from the following eScan screens: Print Zero 

Tape, Ready to Open Polls, Poll Worker Password (access by pressing the Poll Worker 
Button from the Ready to Scan screen), and Polls Closed/Suspended.

  Note:
Logic and Accuracy testing should be performed using only Test mode MBBs written from the “live” 
BOSS election database. 

Do not use Election mode MBBs for Logic and Accuracy testing, unless performing the eScan 
embedded LAT.
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Logic and Accuracy Test Prerequisites

1. The election is written in BOSS.
2. All MBBs are written:

3. The BOSS database is copied to a CD or other media.
4. The BOSS database is finalized for Tally.
5. The BOSS database is copied into Tally.

Test Mode MBBs Election Mode MBBsa

a. Number of Cast Vote Records (CVRs) per MBB is a conservative estimate and will vary depending on the size and complexity of 
the election data.

• 1 MBB for each JBC included in LAT • 1 MBB for each JBC included in Early Voting in person

• 1 MBB for each eScan included in LAT • 1 MBB for each JBC included in Election Day voting

• 1 MBB for each Ballot Now PC included in LAT • 1 MBB for each eScan included in Absentee Voting (by 
mail)

• 1 MBB for warehouse testing (optional) • 1 MBB for each eScan included in Early Voting in person

• 1 MBB for each voting system in use at the Help Desk • 1 MBB for each eScan included in Election Day voting

Audio Cards
• 1 MBB per election source (i.e., Absentee, Early Voting, 

Election Day) for each Ballot Now (Server) PC utilized for 
voting

• 1 Audio Card per DAU eSlate included in the election • 1 MBB per election source for incremental Cast Vote 
Record (CVR) processing (e.g., late mail) for each Ballot 
Now (Server) PC utilized for voting

• 1 Audio Card for warehouse testing (optional) • 1 MBB to enable SERVO to add election Event(s) for 
backup (This MBB can be re-used as one of the JBC or 
eSlate recount MBBs)

• 1 Audio Card for the DAU eSlate in use at the Help Desk • 1 MBB (128 MB) per 65,000 CVRs for JBC CVR recount 
MBBs, using SERVO, for Early Voting in person

• 10% of total as spare Audio Cards
• Hart InterCivic recommends writing at least 10% above the 

number actually needed in the field as spare Audio Cards.

• 1 MBB (128 MB) per 65,000 CVRs for JBC CVR recount 
MBBs, using SERVO, for Election Day in person

• 1 MBB (128 MB) per 65,000 CVRs for eSlate CVR recount 
MBBs, using SERVO, for Early Voting in person

• 1 MBB (128 MB) per 65,000 CVRs for eSlate CVR recount 
MBBs, using SERVO, for Election Day in person

• 1 MBB (128 MB) per 65,000 CVRs for eScan CVR recount 
MBBs, using SERVO, for Absentee (by mail)

• 1 MBB (128 MB) per 65,000 CVRs for eScan CVR recount 
MBBs, using SERVO, for Early Voting in person

• 1 MBB (128 MB) per 65,000 CVRs for eScan CVR recount 
MBBs, using SERVO, for Election Day in person

• 10% of total as spare Election mode MBBs
• Hart InterCivic recommends writing at least 10% above the 

number actually needed for the JBC, eScan, and/or Ballot 
Now units included in Absentee, Early, or Election Day 
voting. 
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Materials
To conduct a LAT, you will need the following:

One of the following options:
• Option 1: A spreadsheet including the ballot styles and options necessary to record one vote for 

each candidate/position included in the test, including straight party and undervote, including 
totals, and including any other vote option that is required by current federal, state, and/or local 
guidelines (e.g., straight party crossover), OR

• Option 2: A test deck of paper ballots reflecting all ballot styles and options necessary to record 
one vote for each candidate/position included in the test, including straight party and undervote, 
and including any other vote option that is required by current federal, state, and/or local 
guidelines (e.g., straight party crossover) for the current election. You must produce Test mode 
paper ballots in Ballot Now if performing the LAT with Ballot Now and/or the eScan.

(Option 2 only) A form for recording the hand tabulation 
An eCM for use with Hart Voting System applications, and that eCM’s signing key programmed, via 
SERVO, to the JBC(s) and/or eScan(s) used in the LAT
An eSlate polling place setup, including at least one JBC and one eSlate, with or without optional 
Verifiable Ballot Option (VBO), per LAT Test Team
One eScan device setup per LAT Test Team
A Ballot Now system setup, including the PC, printer, and scanner, if applicable
Test mode MBBs for the current election; one MBB for each JBC in the LAT, one for each eScan in 
the LAT, and one for Ballot Now, if applicable
Computer workstation(s) with the BOSS and Tally applications
The finalized BOSS database, including at least one Early Voting polling place with all precincts 
assigned
The BOSS “Polling Place List Early Voting Summary” report
The election name and database filename in Tally
An envelope for filing LAT documentation for archive

  See:
  See:The Logic and Accuracy Test Documentation form at the end of this chapter.

A LAT group that is made up of Test Teams:
• One member of the LAT group has the primary responsibility to manage the LAT. This manager 

operates the JBC, and/or distributes paper ballots, and oversees the process.
• Each Test Team is made up of two members. 
• Each Test Team is assigned to cast ballots at a specific eSlate, eScan, or Ballot Now device that 

is being used in the test. 
• Teams should be numbered according to the number of the eSlate, eScan, or Ballot Now devices 

on which the team is assigned to vote.
• One member of each team enters the ballot options into the eSlate or onto the paper ballot, and 

the other checks for accuracy and verifies options on the eSlate Summary Page (and Paper 
Verification Page, if applicable). If testing the eScan or Ballot Now, follow a similar process.
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eSlate System Logic and Accuracy Test Procedure
The eSlate System Logic and Accuracy Test (LAT) procedure consists of seven major steps:

Vote Test Deck Paper Ballots
Tally Zero Report
JBC Zero Report
Cast Matching Votes on the eSlate
Scan Test Deck in Ballot Now 
Tabulate MBBs and Print Tally Reports
Document LAT

The LAT procedure described herein assumes that the test is being performed in Early Voting mode and 
that there is an Early Voting polling place with all precincts assigned in the BOSS database.

Step 1: Vote Test Deck Paper Ballots

Steps for Option 1: Spreadsheet Steps for Option 2: Paper Ballots

Create a ballot options spreadsheet to reflect 
paper ballot voting.

One vote for each candidate/option tested 
should be represented.
A straight party vote is a “candidate.”
Record one blank ballot to test undervotes.
Include any other vote option that is required 
by current federal, state, and/or local 
guidelines (e.g., straight party crossover, 
overvotes, pattern of votes).
The ballot options spreadsheet should include 
indicators, per ballot, for ballot options, and it 
should include tabulation totals.

Print Test mode Ballot Now paper ballots for 
the precincts needed to test each option in 
the election. Print these ballots from the same 
source as those that will be used in the 
election.
Distribute paper ballots to each “Test Team”.

Print Test mode Ballot Now paper ballots for 
the precincts needed to test each option in 
the election, if including Ballot Now in the LAT.  
Print these ballots from the same source as 
those that will be used in the election.

One Test Team member records one vote for 
each candidate on the paper ballots while the 
other Test Team member checks for 
accuracy.
One vote for each candidate/position tested 
should be represented.
A straight party vote is a “candidate.”
Cast one blank ballot to test undervotes.
Include any other vote option that is required 
by current federal, state, and/or local 
guidelines (e.g., straight party crossover).

File the ballot options spreadsheet for 
comparison to the Tally test tabulation reports.

Hand-tabulate the paper ballots. 
File this for comparison to the Tally test 
tabulation reports.
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Step 2: Tally Zero Report

Steps: Details:

1. Log in to Tally as an Administrator-level 
user and create the current election’s 
database in Test mode.

Use the Database Wizard to define database 
options for provisional ballots, split precincts, 
and reporting.
• Provisional Ballots can automatically be 

included in totals or not included.
• Split Precincts can be consolidated or not 

consolidated.  

2. Select the database and define “certified” 
write-ins, if write-ins are on the ballot and 
part of the LAT.

3. Click the Reporting Quick Link.

4. Print a “Cumulative Report.” This is the 
Tally Zero Report.

Select the applicable values for the following 
parameters: 
• Over Under 
• Display Absentee 
• Show/Hide Turn Out Boxes.

5. Exit Tally.
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Step 3: JBC Zero Report

Steps: Details:

1. Insert a Test MBB into the JBC. Before the MBB is inserted, the JBC must 
have the correct signing key programmed 
through SERVO.

2. Power on the JBC. Leave the “JBC Initialized” report and other 
reports that print out on the JBC to file with the 
“Zero Tape” report in an LAT records envelope.

3. Enter the Start-up password.

4. Enter an Early Voting Polling Place I.D. 
that has all ballot styles available.

Refer to the BOSS “Polling Place List Early Voting 
Summary” report.

5. Press the  next to Accept.

6. Press the  next to Yes for “Are you 
performing Early Voting today?”

The LAT can also be performed in Election 
Day mode, but the ballot styles available are 
limited to those precincts available at that 
polling place. (The standard is for all 
precincts, and thus all ballot styles, to be 
available at each Early Voting location.)
If testing in Election Day mode, you may need 
to use multiple JBC/eSlate daisy chains in 
order to make sure that all ballot styles are 
available.

7. Press the  next to Yes to confirm the 
Polling Place location.

If the Polling Place location is incorrect, press the 
 next to NO and try again.

8. Proceed to eSlate booths, and assign 
booth numbers to the eSlates.

9. When you have assigned the last eSlate, 
press the  next to Done on the JBC.

10. Press the  next to Next.

11. Press the  next to Print Zero Tape. Verify that the JBC “Zero Tape” report indicates 
zero votes cast.

12. Compare the “Zero Tape” report from the 
JBC to the Zero Report from the Tally 
application. 

Reconcile any variances.
File the JBC “Zero Tape” report and the Tally 
Zero Report in the LAT records envelope.
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Step 4: Cast Matching Votes on the eSlate

Steps: Details:

1. Review Assignments. The LAT manager should operate the JBC.
• Teams should be assigned team numbers 

that correspond to their eSlate booth 
number.

• Each test team should have one member 
who votes the eSlate, and one member 
who checks each option choice as well as 
verifies those choices on the eSlate 
Summary Page.

2. Distribute assignments documented on 
the LAT ballot options spreadsheet to Test 
Team members or distribute voted paper 
ballots.

3. On the JBC, press the  next to Open 
Polls.

If the device was turned off, plug it in, enter 
the start-up password, and press the ENTER 
key.
Do not tear off reports yet.

4. Enter the Open Polls Password.

5. Press the  next to Add Voter. Repeat steps 5 through 11 for each paper test 
ballot or ballot options spreadsheet assignment.

6. Use the JBC keypad to enter the Test 
Team’s ballot precinct number, and press 
the  corresponding to that number.

7. Press the  next to Print to print an 
access code.

  Tip(s):
Do not tear off the access codes as they 
print. Run the codes in a continuous 
string.  Tear off and distribute per precinct 
assignment. This becomes another record 
of the number of ballots cast during the 
test.

8. Each Test Team votes on the eSlate 
system to match exactly with the paper 
ballot or ballot options spreadsheet 
assignment that team holds.

9. One Test Team member verifies the 
accuracy of that team’s eSlate ballot with 
the Summary Page before pressing 
CAST BALLOT.

If the Summary Page does not match the test 
deck ballot or spreadsheet, the Test Team 
member voting presses the  PREV button and 
corrects the incorrectly voted contest(s). 
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  See:
  See:“eScan System Logic and Accuracy Test Procedure” on page 48 if you are performing an LAT 

with the eScan system also.

10.
10.1  If the VBO is included, one Test Team 

member verifies that the Paper Verifica-
tion Page matches exactly both the 
printed paper trail and the paper ballot 
or ballot options spreadsheet 
assignment that team holds.

10.2  The voting Test Team member 
presses the CAST BALLOT button, 
confirms that he or she wants to cast 
the ballot as is, presses the CAST 
BALLOT button again, the printer prints 
a bar code and the “Ballot Accepted” 
message, and the printed ballot scrolls 
out of view.

If the Paper Verification Page and printed paper 
trail do not match the test deck ballot or 
spreadsheet, the Test Team member voting 
presses the  PREV button, the printer prints 
“Ballot Rejected”, and the voting Test Team 
member corrects the incorrectly voted contest(s).

11. The waving American flag displays on the 
eSlate screen for each ballot cast.

12. After all matching eSlate ballots have 
been voted, press the Close Polls button 
on the JBC.

13. Enter the Close Polls Password.

14. Print the JBC “Daily Detail” report. Or, print the JBC “Tally” report if performing the 
Logic & Accuracy Test in Election Day mode.

15. Confirm that the JBC Public Count has 
recorded the number of eSlate ballots 
cast by test team members, and that the 
JBC “Summary” report reflects this.

The JBC Public Count is printed on the 
“Summary” report, and it is displayed in the 
lower right-hand corner of the JBC screen.
• The Public Count is the number of ballots 

cast for this election on this JBC.
• If the Public Count does not match the 

number of ballots test team members 
think they have cast, reconcile this 
difference using the “Daily Detail” report 
(or JBC “Tally” report).

16. File the JBC reports with the paper ballot 
tabulation/ballot options spreadsheet and 
Zero Reports.

17. Power off the JBC and remove the Test 
MBB. 

18. If the VBO is included, remove the VBO 
box from the eSlate booths, remove their 
printouts, and file these with the other LAT 
documentation.
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Step 5: Scan Test Deck in Ballot Now

If you are performing LAT procedures for Ballot Now also (e.g., the absentee/by-mail system), follow 
these steps:

Steps: Details:

1. Log in to Ballot Now as an administrator-
level user.

Insert both the Test MBB and the eCM. 
Remove both when finished with the Ballot 
Now session. 

Always work in teams in order to assure that 
the proper steps were followed during the 
LAT.
This user is responsible for the integrity of the 
process.

2. If you haven’t already done so, print Test 
mode ballots for each ballot style needed.

3. Print the “Printed Ballots by Precinct” and 
“Election” reports.

The “Election” report, printed at the beginning of 
the Ballot Now LAT process, serves as a Ballot 
Now Zero Report.

4. Teams vote the TEST ballots according to 
the spreadsheet or test deck.

Each test team should have one member who 
votes the ballot, and one member who checks 
each ballot upon completion of voting.

5. Scan the TEST ballots in the proper 
mode.

6. Print the “Scan Batch” report.

7. Resolve overvotes, undervotes, and write-
ins according to state and local 
guidelines.

8. Save Cast Vote Records to the MBB.

9. Close the Election.

10. Print  “Scanned Ballots by Batch”, “Audit 
Log”, and “Election” reports.

The “Election” report, printed at the end of the 
Ballot Now LAT process, serves as a summary of 
Cast Vote Records.

11. Exit Ballot Now. Remove the Test MBB 
and eCM from the Ballot Now PC.
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Step 6: Tabulate MBBs and Print Tally Reports

Steps: Details:

1. Insert the Test MBB(s) into the card 
device on a PC running the Tally program.

2. Log in to the Tally application as an 
Administrator-level user, highlight and 
click Select for the current election’s 
database in Test mode.

3. Insert the eCM into a USB port on the PC 
and enter in the PIN when prompted 
before reading first MBB.

4. Read the Test mode MBB(s) into Tally.
The eCM can be removed once the first MBB is 
read into Tally.

5. Click the Start button in the Tabulation 
box at the bottom of the screen to tabulate 
each MBB’s CVRs.

6. Click the Stop button in the Tabulation 
box to stop tabulating for that MBB.

After reading and tabulating all Test MBBs, click  
the Reporting Quick Link and select the “MBB 
Status” report. This report shows the number of 
cast votes on each MBB. Use this report to 
confirm that the target Test MBBs for LAT have 
been processed.

7. After reading all Test MBB(s), from the 
Election Information panel, click the 
Finalize button to finalize the election in 
Tally.

This finalizes (closes) the Test election Tally 
database.

8. Click the Reporting Quick Link. Select 
and print the official “Cumulative Report.”

Compare this report to the device summary 
report(s).

9. Print the official Tally “Precinct” report. This report shows precinct totals and the origin of 
votes: Election Day, Early Voting, and Absentee.  
Select applicable values for the report 
parameters.

10. Print the official Tally “Canvass” report. This report shows totals, the origin of votes, 
and the breakdown per precinct.  Compare 
this report to the LAT spreadsheet 
assignments per precinct/ballot style.
Review reports and file with other LAT 
documents.
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Step 7: Document Logic and Accuracy Test

Steps: Details:

1. Compare the JBC “Summary” report (and 
the Ballot Now reports, if applicable) and the 
Tally application reports to the spreadsheet 
or the hand counted paper ballot tabulation.

The number of voters and precinct 
assignments should match.
The options voted should match.
Reconcile any variances and document.

2. Place Tally application reports, Tally 
application audit log, JBC reports, paper 
Test Ballots, Ballot Now reports (if 
applicable) and MBBs into the LAT 
envelope. 

Have Test Team members sign and date an 
LAT Documentation Form and add this to the 
LAT records envelope.
Seal the envelope.

  See:
  See:LAT documentation at the end of this 

chapter.

3. Back up the eSlate system audit logs and 
CVR logs, if necessary.

  See:
  See:The SERVO Operations Manual.

4. Disconnect and reset the eSlate system 
used for the Logic and Accuracy Test using 
the SERVO application.

  See:
  See:The SERVO Operations Manual.

5. Power off and pack the eSlate system.

6. Give the sealed LAT records envelope to an 
election official for secure storage.

Follow state statutes and local guidelines for 
archiving these records.
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eScan System Logic and Accuracy Test Procedure
The eScan System Logic and Accuracy Test (LAT) procedure consists of seven major steps:

Vote Test Deck Paper Ballots
Tally Zero Report
eScan Zero Report
Scan Test Deck on the eScan
Scan Test Deck in Ballot Now 
Tabulate MBBs and Print Tally Reports
Document LAT

The LAT procedure described herein assumes that the test is being performed in Early Voting mode and 
that there is an Early Voting polling place with all precincts assigned in the BOSS database.
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Step 1: Print and Vote Test Deck Paper Ballots

Steps for Option 1: Spreadsheet Steps for Option 2: Paper Ballots

Create a ballot options spreadsheet to reflect 
paper ballot voting.

One vote for each candidate/option tested 
should be represented.
A straight party vote is a “candidate”.
Record one blank ballot to test undervotes.
Include any other vote option that is required 
by current federal, state, and/or local 
guidelines (e.g., straight party crossover, 
overvotes, pattern of votes).
The ballot options spreadsheet should include 
indicators, per ballot, for ballot options, and it 
should include tabulation totals.

Print Test mode Ballot Now paper ballots for 
the precincts needed to test each option in 
the election. Print these ballots from the same 
source as those that will be used in the 
election.
Print two test decks, if testing both Ballot Now 
scanners and eScan devices.
Distribute Test mode Ballot Now paper ballots 
to each “Test Team”.

Print Test mode Ballot Now paper ballots for 
the precincts needed to test each option in 
the election. Print these ballots from the same 
source as those that will be used in the 
election.
Print two test decks, if testing both Ballot Now 
scanners and eScan devices.
Mark Test mode Ballot-Now-produced paper 
ballots to match the ballot options 
spreadsheet. One team member marks a 
ballot; the other confirms that the ballot 
matches that row (for example) of the 
spreadsheet.

One Test Team member records one vote for 
each candidate on the paper ballots while the 
other Test Team member checks for 
accuracy.
One vote for each candidate/position tested 
should be represented.
A straight party vote is a “candidate”.
Cast one blank ballot to test undervotes.
Include any other vote option that is required 
by current federal, state, and/or local 
guidelines (e.g., straight party crossover).

File the ballot options spreadsheet for 
comparison to the Tally test tabulation reports.

Hand-tabulate the paper ballots. 
File this for comparison to the Tally test 
tabulation reports.

Scan the paper ballots. Scan the paper ballots.
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Step 2: Tally Zero Report

Step 3: eScan Zero Report

Steps: Details:

1. Log in to Tally as an Administrator-level 
user and create the current election’s 
database in Test mode.

Use the Database Wizard to define database 
options for provisional ballots, split precincts, 
and reporting.
• Provisional Ballots can automatically be 

included in totals or not included.
• Split Precincts can be consolidated or not 

consolidated.  

2. Select the database and define “certified” 
write-ins, if write-ins are on the ballot and 
part of the LAT.

3. Click the Reporting Quick Link.

4. Print a “Cumulative Report.” This is the 
Tally Zero Report.

Select the applicable values for the following 
parameters: 
• Over Under 
• Display Absentee 
• Show/Hide Turn Out Boxes.

5. Exit Tally.

Steps: Details:

1. Insert a Test MBB into the eScan. Before the MBB is inserted, the eScan 
must have the correct signing key 
programmed through SERVO.

2. Power on the eScan. Leave the eScan “Initialized” report and other 
reports that print out on the eScan to file with the 
“Zero Tape” report in an LAT records envelope.

3. Enter the Start-up password and press the 
button next to ACCEPT.

4. Enter an Early Voting or Absentee Polling 
Place I.D. that has all ballot styles 
available and press the button next to 
ACCEPT.

Refer to the BOSS “Polling Place List Early Voting 
Summary” report.
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Step 4: Scan Test Deck on the eScan

5. If applicable, respond to the eScan 
prompt to select your polling place type by 
pressing the button next to Early Voting.

The LAT can also be performed in Election 
Day mode, but the ballot styles available are 
limited to those precincts available at that 
polling place. (The standard is for all 
precincts, and thus all ballot styles, to be 
available at each Early Voting location.)
If testing in Election Day mode, you may need 
to use multiple eScan devices in order to 
make sure that all ballot styles are available.

6. Press the button next to YES to confirm 
the Polling Place location.

If the Polling Place location is incorrect, press the 
button next to NO and try again.

7. Press the button next to PRINT ZERO. Verify that the eScan “Zero Tape” report indicates 
zero votes cast.

8. Compare the “Zero Tape” report from the 
eScan to the Zero Report from the Tally 
application. 

Reconcile any variances.
File the eScan “Zero Tape” report and the 
Tally Zero Report in the LAT records 
envelope.

Steps: Details:

1. Review Assignments. The LAT manager should oversee all 
operations.
• Teams should be assigned team numbers 

that correspond to their eSlate booth 
number.

• Each test team should have one member 
who double checks the scanned ballot 
against the spreadsheet or hand count 
and scans the ballot, and one member 
who performs poll worker functions, as 
necessary, on the eScan.

2. Distribute assignments documented on 
the LAT ballot options spreadsheet to Test 
Team members AND distribute voted 
paper ballots.

3. On the eScan, press the button next to 
OPEN POLLS.

If the device was turned off, switch it on, enter 
the start-up password, and press the button 
next to ACCEPT.
Do not tear off reports yet.

4. Enter the Open Polls password and press 
the button next to ACCEPT.
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5. Scan paper ballots and respond to eScan 
screen prompts.

One Test Team member should verify the 
accuracy of each ballot against the 
spreadsheet before scanning.
One Test Team member should operate the 
eScan as a poll worker, accepting ballots with 
overvotes, undervotes, or blank ballots by 
pressing the Poll Worker Button as 
necessary.

6. After all ballots have been voted, press 
the Poll Worker Button on the back of 
the eScan.

7. Enter the Poll Worker Password and 
press the button next to ACCEPT.

8. Press the button next to SUSPEND 
POLLS.

9. Press the button next to YES to confirm 
that you want to suspend polls.

10. Enter the Close Polls password and press 
the button next to ACCEPT.

11. Print the eScan “Daily Detail” report. OR, print the eScan “Tally” report if performing 
the Logic & Accuracy Test in Election Day mode.

12. Confirm that the eScan Public Count has 
recorded the number of ballots cast by 
test team members, and that the eScan 
reports reflect this.

The eScan Public Count is printed on the 
suspend reports, and it is displayed on the 
eScan screen.
• The Public Count is the number of ballots 

cast for this election on this eScan.
• If the Public Count does not match the 

number of ballots test team members 
think they have cast, reconcile this 
difference using the “Daily Detail” report 
(or eScan “Tally” report).

13. File the eScan reports with the paper 
ballot tabulation/ballot options 
spreadsheet and Zero Reports.

14. Power off the eScan and remove the Test 
MBB.
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Step 5: Scan Test Deck in Ballot Now 

If you are performing LAT procedures for Ballot Now also (e.g., LAT for the absentee/by-mail system), 
follow these steps:

Steps: Details:

1. Log in to Ballot Now as an administrator-
level user.

Insert both the Test MBB and the eCM. 
Remove both when finished with the Ballot 
Now session. 

Always work in teams in order to assure that 
the proper steps were followed during the 
LAT.
This user is responsible for the integrity of the 
process.

2. If you haven’t already done so, print Test 
mode ballots for each ballot style needed.

3. Print the “Printed Ballots by Precinct” and 
“Election” reports.

The “Election” report, printed at the beginning of 
the Ballot Now LAT process, serves as a Ballot 
Now Zero Report.

4. Teams vote the TEST ballots according to 
the spreadsheet or test deck.

5. Scan the TEST ballots in the proper 
mode.

6. Print the “Scan Batch” report.

7. Resolve overvotes, undervotes, and write-
ins according to state and local 
guidelines.

8. Save Cast Vote Records to the MBB.

9. Close the Election.

10. Print  “Scanned Ballots by Batch”, “Audit 
Log”, and “Election” reports.

The “Election” report, printed at the end of the 
Ballot Now LAT process, serves as a summary of 
Cast Vote Records.

11. Exit Ballot Now. Remove the Test MBB 
and eCM from the Ballot Now PC.
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Step 6: Tabulate MBBs and Print Tally Reports

Steps: Details:

1. Insert the Test MBB(s) into the card 
device on a PC running the Tally program. 

2. Log in to the Tally application as an 
Administrator-level user, highlight and 
click Select for the current election’s 
database in Test mode.

3. Insert the eCM into a USB port on the PC 
and enter in the PIN, when prompted, 
before reading the first MBB.

4. Read the Test mode MBB(s) into Tally.
The eCM can be removed once the first MBB is 
read into Tally.

5. Click the Start button in the Tabulation 
box at the bottom of the screen to tabulate 
each MBB’s CVRs.

6. Click the Stop button in the Tabulation 
box to stop tabulating for that MBB.

After reading and tabulating all Test MBBs, click 
the Reporting Quick Link and select the “MBB 
Status” report. This report shows the number of 
cast votes on each MBB. Use this report to 
confirm that the target Test MBBs for LAT have 
been processed.

7. After reading all Test MBB(s), from the 
Election Information panel, click the 
Finalize button to finalize the election in 
Tally.

This finalizes (closes) the Test election Tally 
database.

8. Click the Reporting Quick Link. Select 
and print the official “Cumulative Report.”

Compare this report to the device summary 
report(s).

9. Print the official Tally “Precinct” Report. This report shows precinct totals and the origin of 
votes: Election Day, Early Voting, and Absentee.  
Select applicable values for the report 
parameters.

10. Print the official Tally “Canvass” Report. This report shows totals, the origin of votes, 
and the breakdown per precinct.  Compare 
this report to the LAT spreadsheet 
assignments per precinct/ballot style.
Review reports and file with other LAT 
documents.
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Step 7: Document Logic and Accuracy Test

Steps: Details:

1. Compare the eScan reports (and the 
Ballot Now reports, if applicable) and the 
Tally application reports to the 
spreadsheet or the hand counted paper 
ballot tabulation.

The number of voters and precinct 
assignments should match.
The options voted should match.
Reconcile any variances and document.

2. Place Tally application reports, the Tally 
audit log, eScan reports, eScan and Ballot 
Now scanned Test Ballots, Ballot Now 
reports (if applicable) and MBBs into the 
LAT envelope. 

Have Test Team members sign and date an 
LAT Documentation Form and add this to the 
LAT records envelope.
Seal the envelope.

  See:
  See:The LAT documentation at the end of this 

chapter.

3. Back up the eScan system audit logs and 
CVR logs, if necessary.

  See:
  See:The Support Procedures Training Manual.

4. Using the SERVO application, reset the 
eScan system used for the Logic and 
Accuracy Test.

  See:
  See:The SERVO Operations Manual.

5. Power off, disconnect, and pack the 
eScan system.

6. Give the sealed LAT records envelope to 
an election official for secure storage.

Follow state statutes and local guidelines for 
archiving these records.
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eScan Embedded Logic and Accuracy Test Procedure
The eScan device includes the functionality to perform an embedded Logic and Accuracy Test (LAT). 
This embedded LAT functionality is available to test the device before, during, and/or after voting events 
when the device MBB is present and configured. The embedded LAT function works with Test or 
Election mode MBBs, but only with Test mode ballots. No LAT Cast Vote Record data is saved to the 
MBB or eScan memory (only audit trail data indicating that the test was performed), but the eScan “Tally” 
report can be printed at the end of the embedded LAT. The embedded LAT functionality is available from 
each of these screens when you push the Poll Worker Button:

Print Zero Tape
Ready to Open Polls
Poll Worker Password (press the Poll Worker Button from the Ready to Scan screen)
Polls Closed/Suspended

On each screen, a note (*) indicates the availability of administrator functions, including the embedded 
LAT.

Print Zero Tape Screen Ready to Open Polls Screen

Poll Worker Password Screen Polls Closed Screen
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Steps: Details:

1. After the eScan is powered on, from the 
Print Zero Tape, Ready to Open Polls, 
Poll Worker Password, or Polls Closed/
Suspended screen, press the Poll 
Worker Button in order to access the 
Administrator Menu.

The Poll Worker Button is the red button located 
on the back of the eScan device.

2. Enter the Administrator Password and 
press the button next to ACCEPT.

3. Press the button next to LAT.

Administrator Menu Screen

4. The Logic and Accuracy Test screen 
appears.

Logic and Accuracy Test Screen
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5. Follow the prompts to insert Test mode 
ballots for the LAT.

Only Test mode ballots may be scanned.
As LAT ballots are scanned, only the Private 
Count increases; the Public Count does not.
Cast Vote Records from LAT ballots are not 
stored in eScan memory or to the MBB.

  Note:
When you conduct an embedded LAT, the 
eScan will accept any test ballot the first 
time you scan it, regardless of the BOSS 
database settings.  Ensure that you have 
marked the test ballots correctly (i.e., 
without overvotes) before inserting them 
into the eScan.

6. After all LAT ballots have been scanned, 
press the button next to Print Tally.

7. Compare the eScan “Tally” report to a 
hand count (or spreadsheet) of the voted 
paper ballots.

The number of ballots voted should match.
The precinct(s) voted should match.
The options voted should match.

8. Sign the eScan “Tally” report, indicating 
that the LAT was accurate.

OR Indicate discrepancies (e.g., errors on the 
hand count or spreadsheet).

9. File the eScan “Tally” report in a marked 
envelope.

Follow state and local guidelines to complete and 
file LAT documentation.

10. Press the eScan power switch to the OFF 
position. 
 
OR Follow screen prompts to exit LAT 
mode.



L_LATlog_rev12.17.05.doc 

Logic and Accuracy Test Documentation 
Follow Hart Voting System LAT procedures. Complete and sign the following form as 
documentation of the LAT. 
 

 Tally Zero Report 

 JBC Open Polls diagnostic 

 JBC Zero Report  

 JBC Summary Report from suspending 

polls 

 Full Verifiable Ballot Option printout 

 eScan Open Polls diagnostic 

 eScan Zero Report 


 eScan Summary Report from 
suspending polls 


 Ballot Now Printed Ballots, Scanned 
Ballots, Election and Audit Trail reports 


 Official reports from Tally 

 Test MBBs 

 Tally Audit Log printout 

 

Election Title: 
 

BOSS folder (file path): MBB ID 
Number: LAT Date: 

   

 
Testing group agrees:  Logic and Accuracy Test is complete and accurate. 
 

Title Printed Name and Initials 
LAT Manager  
Team 1 member  
Team 1 member  
Team 2 member  
Team 2 member  
Team 3 member  
Team 3 member  
Team 4 member  
Team 4 member  
Team 5 member  
Team 5 member  
Team 6 member  
Team 6 member  
Team 7member  
Team 7 member  
Team 8 member  
Team 8 member  
Team 9 member  
Team 9 member  
Team 10 member  
Team 10 member  
Team 11 member  
Team 11 member  
Team 12 member  
Team 12 member  

 



LAT Envelope Label for Avery style 5164      F2_LATenvLabel5164_rev6.08.05 

Logic and Accuracy Test 
Envelope 

 
Election Title: ____________________________
 
Election Date: ____________________________
 
LAT Date: _______________________________ 
Comments: 
 
 
 
LAT Manager Signature: 
 
________________________________________ 

 

Logic and Accuracy Test 
Envelope 

 
Election Title: ____________________________
 
Election Date: ____________________________
 
LAT Date: _______________________________ 
Comments: 
 
 
 
LAT Manager Signature: 
 
________________________________________ 

   

Logic and Accuracy Test 
Envelope 

 
Election Title: ____________________________
 
Election Date: ____________________________
 
LAT Date: _______________________________ 
Comments: 
 
 
 
LAT Manager Signature: 
 
________________________________________ 

 

Logic and Accuracy Test 
Envelope 

 
Election Title: ____________________________
 
Election Date: ____________________________
 
LAT Date: _______________________________ 
Comments: 
 
 
 
LAT Manager Signature: 
 
________________________________________ 

   

Logic and Accuracy Test 
Envelope 

 
Election Title: ____________________________
 
Election Date: ____________________________
 
LAT Date: _______________________________ 
Comments: 
 
 
 
LAT Manager Signature: 
 
________________________________________ 

 

Logic and Accuracy Test 
Envelope 

 
Election Title: ____________________________
 
Election Date: ____________________________
 
LAT Date: _______________________________ 
Comments: 
 
 
 
LAT Manager Signature: 
 
________________________________________ 
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Notes:
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Chapter 4

Coordinating Definitions in Tally and Rally

The purpose of this chapter is to clarify the manner in which Tally and Rally must be coordinated in order 
to communicate successfully. An understanding of Tally-Rally configuration requirements is essential 
before embarking on the detailed steps required to use Tally-Rally in a live election. Accordingly, it is not 
the purpose of this introductory chapter to explain those steps, which are reserved for the following 
chapter.

To ensure successful Tally-Rally communications, the following settings must be configured in both Tally 
and Rally in a coordinated manner:

1. Establish User IDs and Permissions: The election event Tally operator must exist at each Rally 
station as a user with MBB processing/transferring permissions.

2. Update Certificates: Complete and/or update Tally and Rally certificates, and make certain that 
software application operators are aware of valid certificate contents so that they can verify and 
accept certificates. If certificates are verified and accepted during Tally-Rally testing, then they 
should not need to be verified again during normal Election Day Tally-Rally communications. This 
verification and acceptance during Tally-Rally testing is the recommended procedure.

3. Set Up Rally Station Information: A record of each Rally station must exist in Tally with a 
unique station name and IP address. The information entered in Tally for each station must 
match the information from each Rally station’s PC.

4. Configure Dial-In Access, if applicable: At Rally stations using a dial-in modem connection to 
transfer data, the User ID and password of the election event Tally operator must be entered as 
the “modem name” and “modem password.”

The remaining sections of this chapter explain how administrator-level users must complete these 
coordinated settings.

  Note:
Tally and Rally PC hardware must also be configured for LAN and/or modem communication. 

  See:
  See:“Appendix E: Windows Tally and Rally LAN Setup” on page 117. 

“Appendix F: Windows Tally and Rally Modem Setup” on page 121.

“Appendix M: Best Practices for Tally-Rally Setup” on page 177.

  Tip(s):
Test Tally-Rally communications before every live election event.
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Part 1: Establish User IDs and Permissions
Add the election event Tally operator as a user in Rally.

Tally Settings

The election event Tally operator must have at least operator-level permissions in Tally.

Rally Settings

In Rally’s User Settings window, the election event Tally operator must be configured with at least MBB 
processing/transferring permissions.

  See:
  See:“Tally User Permissions and Certificate” on page 15.
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Part 2: Update Certificates
Complete and/or update Tally and Rally certificates, and make certain that software application 
operators are aware of valid certificate contents so that they can verify and accept certificates. If 
certificates are verified and accepted during Tally-Rally testing, then they should not need to be re-
verified during normal Election Day Tally-Rally communications. This verification and acceptance during 
Tally-Rally testing is the recommended procedure.

Tally Settings

1. As a Tally user with operator or administrator permissions, go to the 
Options menu and click Transfer Configuration to access the Rally 
Configuration window.

2. On the Basic Setup tab, click the Certificate 
button.

3. If necessary, update certificate information in 
the Certificate window and click OK.

Rally Settings

1. As a Rally user with operator or administrator permissions, go to the 
Tools menu and click Certificate, or click the Certificate icon in the 
toolbar.

2. If necessary, update certificate information and click OK.
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Part 3: Set Up Rally Station Information
Add basic station information to match in Tally and Rally.

Tally Settings

1. As a Tally user with operator or administrator 
permissions, go to the Options menu and 
click Transfer Configuration to access the 
Rally Configuration window.

2. In the Rally Station Name field of the Basic 
Setup tab, enter the name of a Rally station.

3. Go to the Connect Every drop-down menu 
and click the time interval for Tally 
connections to Rally.

4. In the Station IP Address field, enter the IP 
address of the Rally station PC.
> For Rally stations using modem 

connections, this should be the “From” 
TCP/IP address. 

5. Click the Add button.
6. Repeat the steps for basic setup to create 

additional Rally stations (highlight fields, 
enter new station data, and click Add).

Rally Settings

At each Rally station, in the Options window, the Station Name field should match the Rally station 
name in Tally’s Rally Configuration window, Rally Station Name field. 

Station names should be unique from other Rally stations and Rally PC names.
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Part 4: Configure Dial-In Access (if applicable)
Enable dial-in access and associate the election event Tally operator with each Rally station’s modem 
name.

Tally Settings

1. If Tally will use a dial-in modem to 
communicate with a Rally station, highlight 
the Rally station name in the Rally Station 
List panel.

2. Select the Dial-in Access Configuration 
tab.

3. Select the A modem is required... 
checkbox.

4. In the Phone Number field, enter the Rally 
station PC modem’s phone number.

5. In the User ID and Password fields, enter 
the User ID and Password of the election 
event Tally operator (or another unique user 
name and password that will match the Rally 
Dial-In Access tab information).

6. Select the Update button to update the basic 
setup information with dial-in access 
configuration details for this Rally station.

Rally Settings

At Rally stations using a modem connection to transfer data, complete the Dial-In Access tab in the 
Options window.

The Rally Modem Name and Modem Password fields MUST match the User ID and Password 
fields entered in Tally’s Rally Configuration window, Dial-In Access Configuration tab.
All Rally stations using modem connections will use the same Modem Name and Modem 
Password for an election.
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Notes:
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Chapter 5

Using Tally-Rally to Count Voted MBBs

The following procedures outline the steps for tabulating an election with the Tally and Rally applications.

  See:
  See:“Logic and Accuracy Testing Procedures” on page 37.

Part 1: Tally and Rally Configuration

Steps: Details:

1. In the BOSS program, finalize the BOSS 
database for Tally.

Make certain all MBBs and DAU cards have 
been written before finalizing the BOSS 
database.

After finalizing, no additional cards can be 
written.

2. Physically set up Tally and Rally PC 
hardware and Windows LAN and/or 
modem configurations.

  See:
  See:“Appendix E: Windows Tally and Rally 

LAN Setup” on page 117. 

“Appendix F: Windows Tally and Rally 
Modem Setup” on page 121.

3. Double-click the Tally desktop shortcut to 
open the application.

4. Log in to Tally as a user with Administrator 
permissions.

5. If you haven’t already done so, set up 
Tally users and permission levels.

Go to the Options menu and click User 
Configuration.

  See:
  See:“Tally User Permissions and Certificate” 

on page 15.
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6. Create and name/describe a new Test or 
Election mode database in Tally by 
copying the finalized BOSS database or 
importing an existing Tally database from 
file.

Click the Election Databases Quick Link and 
click the New button to bring in a finalized 
BOSS database, or click the Import button to 
import an existing Tally database from file.
With the Database Wizard, set the Tally 
database configurations for split precincts, 
reporting display, and tabulation processing.
Set Database Configuration when creating 
the database, or after opening the database 
and before reading MBBs by going to the 
Options menu and selecting Database 
Configuration.
Test mode and Election mode databases are 
created in Tally separately.
Each Tally database must have a unique 
name/description.
Only one Tally Election mode database for a 
specific BOSS database may exist in a NEW 
or OPENED state at one time.

  See:
  See:Suggested naming conventions in “Tally 

Menus” on page 7.

7. Highlight the target database, and click 
Select to open it.

Steps: Details:
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8. Set the Tally reporting options for report 
labeling, candidate cross-filing, and write-
in reporting.

Go to the Options menu and click Reporting 
Options.

9. (Optional) Change the ballot source labels 
that appear on reports.

Go to the Options menu and click Label 
Options.

10. (Optional) In Tally, define qualified write-in 
candidates and aliases, if applicable.

To define write-in candidates before reading 
MBBs, click the Write-In Resolution Quick 
Link.

  Note:
Write-in candidates and aliases can be 
defined before and/or after MBBs are 
read. Write-in votes matching a candidate 
or alias name will automatically assign to 
that candidate.

  Tip(s):
Defining candidates AFTER reading 
MBBs may be a more efficient process 
unless all write-in candidates and aliases 
are known before tabulation.

Steps: Details:



Tally Training Manual 6300-005 62C

Page 72 Chapter 5 Using Tally-Rally to Count Voted MBBs © Hart InterCivic, Inc.

11. In Tally, verify and enable Rally 
Configuration options for LAN and/or 
modem connections.

Go to the Tally application Options menu and 
click Transfer Configuration.
For a LAN or a modem connection, in Tally, 
verify the Rally Configuration window Basic 
Setup tab information:
• Stop
• Enable Remote Transfer
• Rally Station Name
• Connect Every (time interval)
• Station IP Address.
For a modem connection, in Tally, also verify 
the Dial-in Access Configuration tab:
• Checked A modem is required… 

checkbox
• (Rally Station PC) Phone Number
• User ID that matches the Rally station’s 

Options window, Modem Name field
• User Password that matches the Rally 

station’s Options window, Modem 
Password field.

12. In Tally, verify certificate information. In Tally, select the Certificate button in the Rally 
Configuration window.

13. Exit Tally (optional). Go to the File menu and select Exit.
Exit Tally if a different user is identified as the 
election event Tally operator for Tally-Rally 
functions.

14. At each Rally station, open the Rally 
application and log in as a user with all 
permissions.

All Rally directives apply to each Rally station.
If you haven’t already done so, assign Rally 
user names, passwords, and permissions.

  See:
  See:The Rally Training Manual for Rally 

operator procedures.

Steps: Details:
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15. In Rally, reset the database, and then 
enter the station name as defined in 
Tally’s Rally Configuration window.

To reset the Rally database, go to the Rally 
application Database menu and click Reset.
To enter the Rally station name, click the 
Rally application Options Quick Link and 
click the Station tab.

16. In Rally, at stations connecting to Tally via 
modem, verify dial-in options.

If using a modem connection, click the Rally 
application Options Quick Link and click the 
Dial-in Access tab.
• Select Allow Dial-In Access.
• Enter the Modem Name and Modem 

Password as entered in Tally’s Rally 
Configuration window (this is identical to 
the election event Tally operator User ID 
and Password in the Tally application).

• All Rally stations using modem 
connections will use the same Modem 
Name and Modem Password for an 
election.

17. In Rally, if you haven’t already done so, 
set up the Rally station operator as a user 
with at least Information archiving, MBB 
processing/transferring, and Reporting 
permissions.

Go to the Rally application Tools menu and click 
User Settings.

Steps: Details:
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18. In Rally, if you haven’t already done so, 
set up the election event Tally operator as 
a user with at least MBB processing/
transferring permissions.

Go to the Rally application Tools menu and click 
User Settings.

19. In Rally, verify certificate information. In Rally, go to the Tools menu and click 
Certificate, or click the Certificate icon on the 
toolbar.

20. Exit Rally. Go to the File menu and click Exit.

Steps: Details:
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Part 2: Election Day Tally-Rally Steps

Steps: Details:

1. Log in to Tally as the election event 
operator and select the target election.

  Note:
Make certain to log in with the same user 
name and password used to configure 
Rally stations (for MBB transfer and dial-in 
access).

2. Create a Tally “Zero Report”. Click the Reporting Quick Link and select the 
“Cumulative Report” before reading any MBBs 
into Tally or Rally.
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2.1  Select report options available, click 
OK, and view the report.

Print hard copy.
Export to file in an available soft copy format 
via the report export tool.

  Note:
Report options available will vary per 
report type and election type. The 
graphics at left show the “Cumulative 
Report” options for a general election 
(top) and primary election (bottom).

3. If you haven’t already done so, insert the 
eCM into a USB port.

The eCM can be removed from the USB port 
after the first MBB for the session has been 
read into Tally.
Store the eCM in a secure location.
Each Rally station must also have an eCM in 
order to read the first MBB per session, per 
PC.
The simplest way to use an eCM is to keep 
the device handy (e.g., on a lanyard on your 
person) and to insert the eCM into a USB port 
on an election PC each time that PC is being 
used, removing the eCM when finished.

Steps: Details:
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4. Process Absentee and Early Voting 
MBBs.

Click the Election Information Quick Link.
After the first MBB for the session is inserted 
into the card reader, the Tally application will 
prompt the operator to enter the eCM PIN.

Tally automatically reads subsequent MBBs 
as they are inserted into the card reader. 
To tabulate, select the Start button in the 
Election Information panel of the Tally 
window. The Start button may be selected 
while reading MBBs.
For a Logic & Accuracy Test (LAT), process 
Test mode MBBs in a Test mode Tally 
database.

  See:
  See:“Logic and Accuracy Testing Procedures” 

on page 37.

  Note:
You must stop tabulation in order to use 
the other Quick Links.

5. Print reports. Stop tabulation.
Click the Reporting Quick Link.
Print hard copies of desired reports.
Export soft copies of desired reports in 
available formats via the report export tool.

Steps: Details:
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6. For risk-reduction and archival purposes, 
back up the Tally database to a time-
stamped folder.

Click the Election Information Quick Link.
The Backup button in the Election 
Information window will back up the original 
TallyData.db and TallyData.cfg files to another 
location on the PC hard drive.
The file path to the Tally database folder 
(identified in the Election Databases panel of 
the Tally window) is:
C:\Program Files\Hart InterCivic\Tally
\Database\YearMonthDay-
HourMinuteSecond (YYMMDD-HHMMSS).

  See:
  See:“Appendix D: Backing Up Election 

Databases” on page 115.

7. At each Rally station, operator-level users 
log in.

All Rally directives apply to each Rally station.

8. In Rally, print “Zero Reports”. Rally operators click the Rally application 
reporting Quick Links.

• Rally operators print each report.

Steps: Details:
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9. In Tally, enable Rally stations and start 
remote transfer.

Go to the Options menu and click Transfer 
Configuration.

• Select the Enable checkbox next to Rally 
station names being used

• Select the Start radio button.

10. In Tally, process Election Day MBBs. In Tally, click the Election Information Quick 
Link.
Tally automatically reads MBBs as they are 
inserted into the card reader. 
To tabulate, click the Start button in the 
Election Information panel of the Tally 
window. You can click the Start button while 
reading MBBs.

  Note:
Normal Tally functioning may continue 
while Rally connections are being made. 
You must stop tabulation in order to use 
the other Tally Quick Links.

Steps: Details:
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11. In Rally, process Election Day MBBs. At each Rally station, the operator must insert an 
eCM and enter the PIN in order to read the first 
MBB for the Rally session.

  See:
  See:The Rally Operations and Training 

Manuals for more information on 
processing MBBs in Rally.

12. In Tally, the first connection with each 
Rally PC includes accepting a security 
certificate from Rally. Verify and click Yes 
to accept this certificate.

This step may have been completed during Tally-
Rally testing.

  Tip(s):
Make certain that Tally and Rally 
operators are aware of the contents of 
security certificates, so that they can 
verify and accept.

13. In Rally, the first connection with the Tally 
PC includes accepting a security 
certificate from Tally. Verify, and then 
select Yes to accept this certificate.

This step may have been completed during Tally-
Rally testing.

  Tip(s):
Make certain that Tally and Rally 
operators are aware of the contents of 
security certificates, so that they can 
verify and accept.

Steps: Details:
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14. In Tally, verify that accepted Rally stations 
display “Yes” in the Trusted field of the 
Rally Configuration window.

Go to the Options menu and click Transfer 
Configuration.

• If the Tally or Rally certificate was not 
accepted, Tally and Rally operators 
should communicate (e.g., via mobile 
phone), log out of both applications, log 
back in, and re-establish communication 
(Tally operator can highlight the target 
Rally station in the Rally Configuration 
window and click the Connect Now 
button).

  See:
  See:“Tally-Rally Troubleshooting” on page 93.

15. In Tally, print reports. In Tally, Stop tabulation.
Click the Reporting Quick Link.
Print hard copies of desired reports.
Export soft copies of desired reports in 
available formats via the report export tool.

Steps: Details:
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16. For risk-reduction and archival purposes, 
back up the Tally database to a time-
stamped folder.

Click the Election Information Quick Link.
The Backup button in the Election 
Information window will back up the original 
TallyData.db and TallyData.cfg files to another 
location on the PC hard drive.
The file path to the Tally database folder 
(identified in the Election Databases panel of 
the Tally window) is:
C:\Program Files\Hart InterCivic\Tally
\Database\YearMonthDay-
HourMinuteSecond (YYMMDD-HHMMSS).

  See:
  See:“Appendix D: Backing Up Election 

Databases” on page 115.

17. In Rally, print reports. In Rally, operators click the Quick Links to access 
reports.

• Print hard copies of desired reports and 
export soft copies in available formats 
using the report export tool.

18. In Tally, consult reports to verify that all 
expected Rally station MBB data has 
been received. 

Click the Reporting Quick Link, and view/
print the following:
• “MBB Status Report”, filtered for MBBs 

read
• “Precinct Election Day Status (with MBB 

IDs)” report, sorted by precinct
Tally and Rally stations should confirm (e.g., 
via mobile phone contact) the following:
• All polling places/precincts expected to 

report have been confirmed as reported
• All expected MBBs have been processed 

in Rally
• All expected data has been received in 

Tally before a Rally station operator logs 
off

19. Exit Rally. Rally databases should be archived, but this step 
can be performed at a later date.

  See:
  See:“Appendix D: Backing Up Election 

Databases” on page 115.

Steps: Details:
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20. From each Rally station, transport 
processed MBBs and Rally reports to the 
counting station.

21. In Tally, after processing all MBBs, 
process Early Voting Retrievable ballots, if 
applicable.

            OR Import retrievable data.

  See:
  See:“Tally Install Settings” on page 12.

“Appendix I: Importing Data” on page 155.

Click the Retrievable Ballots Quick Link.
• Select a column heading to sort on that 

column, for example,
• Right-click a Status cell in order to 

change a single ballot’s status

• OR Use Ctrl-click or Shift-click to select 
several rows, then right-click to change 
the status of multiple ballots

• Select the Confirm box for each ballot for 
which the status has been finalized and 
print the “Retrievable Ballot” report.

Early Voting Retrievable resolution is also 
available after finalizing the database.

Steps: Details:
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22. Include or confirm exclusion of provisional 
ballots, if applicable.

            OR Import provisional data.

  See:
  See:“Tally Install Settings” on page 12.

“Appendix I: Importing Data” on page 155.

Click the Provisional Ballots Quick Link.
• Select a column heading to sort on that 

column.
• Click a Status cell in order to change a 

single ballot’s status.

• OR Use Ctrl-click or Shift-click to select 
several rows, then right-click to change 
the status of multiple ballots.

• Select the Confirm box for each ballot for 
which the status has been verified.

Provisional ballot resolution is also available 
after finalizing the database.

23. Parse provisional ballots, if applicable.

            OR Import provisional data.

  See:
  See:“Tally Install Settings” on page 12.

“Appendix I: Importing Data” on page 155.

Provisional parsing modifies the tabulation of 
the provisional ballot so that only those 
contests on the voter’s true voting precinct 
ballot will be reported.
During Tally installation, settings are selected 
enabling parsed ballots to report to either the 
original (voted) precinct or the reassigned 
(true) precinct.

  See:
  See:“Tally Install Settings” on page 12.

To parse a ballot:
• Select the precinct cell for the target 

ballot.
• Right-click and select the target precinct 

to reassign the ballot to. 
• Select the Confirm box for each ballot for 

which the status has been verified.
Provisional parsing is also available after 
finalizing the database.

24. Print the “Ballot Status” report for 
provisional ballots, if applicable.

Click the Reporting tab and double-click 
Ballot Status in the list of reports.
In the Ballot Status field, select Included.
In the Ballot Type field, select Provisional.
Click OK and print the report.

Steps: Details:
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25.  Resolve votes for write-in candidates, if 
applicable.

25.1  Resolve write-in votes from the eSlate 
and Ballot Now.

Click the Write-In Resolution Quick Link.
• Add qualified write-in candidates and 

aliases. 
> To add candidates after reading 

MBBs,  highlight and click the full and 
correct spelling of the candidate name 
in the Unresolved Write-in Votes 
panel.  In the Add Write-In 
Candidate window, click the Add 
button, and then click the Save button 
to move the candidate over to the 
Candidates/Aliases panel.

> If there is a blank entry in the 
Unresolved Write-in Votes panel, 
then a voter has selected a write-in 
option, but entered no data.

• To assign unresolved votes to candidates, 
select the target candidate in the 
Candidates/Aliases panel, select the 
target alias name in the Unresolved 
Write-in Votes panel, and select the 
uppermost left-pointing arrow.

• To reject unresolved votes, select the 
target name in the Unresolved Write-in 
Votes panel and select the lower left-
pointing arrow to assign these to the 
Rejected Write-in Votes panel.
> Use Ctrl-click and Shift-click to make 

multiple selections.

  Note:
You can also resolve write-in candidates 
after finalizing the database.

Steps: Details:
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25.2  Resolve write-in images and votes 
from the eScan.

Before Write-In Resolution

After Write-In Resolution

Click the Write-In Resolution Quick Link.
• Resolve write-in images so Tally can 

recognize them. 
> Select a contest with write-ins and 

select the Resolve Images button.
> Enter the name of the write-in 

candidate in the Enter Write-in Data 
field of the WriteIn Image Resolving 
- <contest name> window and select 
the Assign button.

> OR Select the name from the WriteIn 
Data Selection List.

> Select the Close button in the WriteIn 
Image Resolving - <contest name> 
window. The name is added to the 
contest’s Unresolved Write-In Votes 
list.

• Resolve write-in votes using the same 
resolution process as eSlate and Ballot 
Now.
> Add qualified write-in candidates and 

aliases.
> Assign unresolved votes to 

candidates.
> Reject unresolved votes.

  See:
  See:See step 25.1  on page 85 for more 

detailed instructions on resolving write-in 
votes.

Steps: Details:
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26. Calculate vote adjustments, if applicable. Go to the Options menu and click Vote 
Adjustments.
• Select the precinct (and split, if 

applicable).
• If adjusting votes for a primary election, 

select the party.
• Select the ballot source (Early Voting, 

Absentee, or Election Day).
• For each contest on a ballot, enter the 

adjustment to the appropriate option by 
selecting the corresponding item in the 
Adjustment column.
> Enter adjustments for overvoted and 

undervoted contests, in addition to 
properly marked ones. 

  Tip(s):
Think of manual vote adjustments as 
being made per ballot.

The number of ballots voted is calculated 
based on the maximum number of votes 
for any one contest in a precinct/split. For 
this reason, it is important that overvotes 
(e.g., for paper ballot adjustments) and 
undervotes be accurately registered.

You can also adjust votes after finalizing the 
database.

27. For risk-reduction and archival purposes, 
back up the Tally database to a time-
stamped folder before finalizing.

Click the Election Information Quick Link.
The Backup button in the Election 
Information window will back up the original 
TallyData.db and TallyData.cfg files to another 
location on the PC hard drive. 
The file path to the Tally database folder 
(identified in the Election Databases panel of 
the Tally window) is:
C:\Program Files\Hart InterCivic\Tally
\Database\YearMonthDay-
HourMinuteSecond (YYMMDD-HHMMSS).

  See:
  See:“Appendix D: Backing Up Election 

Databases” on page 115.

Steps: Details:
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28.  After all MBBs have been processed, 
finalize the election in Tally.

Before finalizing, read spare MBBs that were 
not used in the election in order to account for 
all MBBs.
You can finalize the database before 
processing Early Voting retrievable ballots, 
provisional ballots, write-ins, or vote 
adjustments.
To finalize, click the Election Information 
Quick Link and click the Finalize button.

29. Print standard reports. In Tally, after finalizing, report labels default to 
“Official”. To change labeling to “Unofficial”, 
go to the Options menu and click the 
Reporting Options tab. 
Print hard copies of desired reports.
Export soft copies of desired reports in 
available formats via the report export tool.

  Tip(s):
Back up the database after releasing each 
set of reports as a risk-reduction step.

  See:
  See:“Appendix D: Backing Up Election 

Databases” on page 115.

Steps: Details:
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30. Create and print Custom Reports by 
clicking the Tally Report Wizard button 
in the Reporting window.

Create and print district reports with the 
Report Wizard.
A. Enter a unique Report Name that will 

appear in the Tally reports list.
B. Select a Base Report using the drop-

down arrow.
C. Enter a unique Report Title to appear at 

the top of the report.
D. Select Next and follow prompts.

> In the Precinct Filter step, choose the 
desired district from the drop-down list 
and all associated precincts will be 
selected for the report, or create a 
new set of precincts.

If a previously undefined district is needed for 
reports, go to the File menu and click Import 
to import a .csv or .txt district definition file.

  See:
  See:“Appendix I: Importing Data” on page 155.

31. For risk-reduction and archival purposes, 
back up the Tally database to a time-
stamped folder.

Click the Election Information Quick Link.
The Backup button in the Election 
Information window will back up the original 
TallyData.db and TallyData.cfg files to another 
location on the PC hard drive.
The file path to the Tally database folder 
(identified in the Election Databases panel of 
the Tally window) is:
C:\Program Files\Hart InterCivic\Tally
\Database\YearMonthDay-
HourMinuteSecond (YYMMDD-HHMMSS).

  See:
  See:“Appendix D: Backing Up Election 

Databases” on page 115.

Steps: Details:
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32. Import data, if necessary. Go to the File menu and click Import to 
import files via the Tally Import Wizard.
Importing data may be performed at any time.
Import types include:
• District Definition - to update precinct/

district associations
• Provisional Ballot Status - to update 

include/exclude status and parsing of 
provisional ballots

• Registered Voters - to update the number 
of registered voters per precinct as 
defined in BOSS

• Retrievable Ballot Status - to update 
include/exclude status of retrievable 
ballots.

  Tip(s):
Import files may originate from a Voter 
Registration system. 

  See:
  See:“Appendix I: Importing Data” on page 155.

33. If data was imported, repeat reporting and 
database backup steps.

Steps: Details:
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34. Export data, if necessary. Go to the File menu and click Export to 
export files via the Tally Export Wizard.
Exporting data may be performed at any time.
Export types include:
• Landscape Vote Totals - aggregated vote 

totals in a landscape .txt format
• EDX - Election Data eXchange XML 

format for integration with other systems
• Detail Vote Totals - filtered for Absentee, 

Early Voting, and/or Election Day results 
in .txt format

• Provisional Ballot Status - codes included/
accepted and excluded/rejected in .txt 
format

• Retrievable Ballot Status - codes 
included/accepted and excluded/rejected 
in .txt format

• Registered Voters - registered voter data 
in .csv format

  Note:
When creating Registered Voters export 
files for primary elections, select the 
Export By Party checkbox so the vote 
totals can be re-imported.

Also export reports with the Export tool 
available in each Tally report toolbar.

  See:
  See:“Appendix J: Exporting Data” on 

page 163.

35. Exit Tally. Go to the File menu and click Exit.

Steps: Details:
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Notes:
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Chapter 6

Tally-Rally Troubleshooting

The following table presents possible Tally-Rally issues and resolution steps for each.

Problem: Resolution Steps:

Connection from Tally is 
repeatedly unsuccessful

1. Check LAN and/or modem wiring connections.
2. Verify that the Tally application has the correct phone number(s) 

and IP address(es) entered for each Rally station.

  See:
  See:“Appendix F: Windows Tally and Rally Modem Setup” on 

page 121.

3. Verify that the election event Tally operator has correct user 
permissions on each Rally station’s PC.

4. Verify that the Tally operator is logged into Tally with the correct 
User ID  and password.

5. Verify that both Tally and Rally have accepted certificates from 
each other. 

5.1  In Tally, the Rally Configuration window will indicate whether 
the station is trusted (Yes), or not (No). 

5.2  In Rally, check the “Internal Audit Report” to see that the Tally 
certificate has been accepted.

5.3  If either Rally or Tally has not accepted the other’s certificate, 
log out of both applications and log back in. Attempt 
connection from Tally. 

5.31  Tally operator should highlight the target Rally station in 
the Rally Configuration window and select the Connect 
Now button.
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Connection from Tally is 
repeatedly unsuccessful

(continued)

6. If using a modem connection, verify that Tally’s Rally 
Configuration settings match the Modem Name and Modem 
Password on the Dial-in Access tab in Rally, and that Allow 
Dial-in Access is enabled.

7. If using a modem connection, verify that the Tally and Rally PC 
modems are configured to the same maximum speed.

  See:
  See:“Appendix F: Windows Tally and Rally Modem Setup” on 

page 121.

8. If using a modem connection, check the Windows OS password 
policy for the Tally modem user name on the Rally PC to make 
certain that the maximum password age has not expired.

9. Verify Rally’s station name:
9.1  Go to the Tools menu and click Options. Click the Station tab 

and view the Name field.
9.2  Make sure the Name field matches Tally’s Rally 

Configuration window Rally Station Name field.
9.3  The station name is not the Rally PC name or the current Rally 

operator’s User ID.

10. If necessary, exit Rally, restart the PC, and then open Rally and 
log in.

Problem: Resolution Steps:



6300-005 62C Tally Training Manual

© Hart InterCivic, Inc. Chapter 6 Tally-Rally Troubleshooting Page 95

Connection from Tally 
initially successful, but 
then interrupted and lost

AND 
Tally did not receive data

1. Check connections.
2. Resend the ballots in Rally, and Rally will re-submit them when 

Tally makes the next connection:
2.1  Go to the Tools menu and click Resend Ballots.

2.2  Click Yes in the Resend Ballots dialog box.

2.3  Tally rereads all ballot data from this Rally station on the next 
connection. Tally rejects any ballot data that it has already 
successfully processed.

Do not reread MBBs at the Rally station. MBB data is not reset 
with the Resend Ballots command.

Do not attempt to reset the Rally database.

Login to Rally 
unsuccessful

1. Verify the spelling, case, and spacing of the User ID and 
Password.

2. A user with appropriate permissions may add users.

MBBs are not reading 
into Rally

1. Check that ONLY ONE card device is connected to the PC.
2. Check the card device connection to a USB port on the PC.
3. Check that the card device’s green light is on (power indicator).
4. Exit Rally, shut down the PC, insert an MBB into the card device, 

power on the PC, and log in to Rally.

Rally displays an MBB 
information message

1. Read the message and check the Rally window and reports to 
confirm information.

2. Click OK and continue operations.

Problem: Resolution Steps:
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Rally displays a printer 
error message

1. Click OK in the Realtime Printer Error dialog box.
2. Exit Rally.
3. Check the line printer.

3.1  Is it turned on?
3.2  Is the paper jammed or has the paper run out?
3.3  Is it connected to the Rally PC?

4. Log in to Rally.
5. If the problem persists:

5.1  Go to the Tools menu and click Options.
5.2  Click the Line Printer tab and set the “Audit Printer Settings” 

to “FILE.”
5.3  Exit and re-enter Rally. 
5.4  The real-time audit report will print to a file named “FILE” in the 

directory, C:\Program Files\Hart InterCivic\Rally.

  See:
  See:“Setting Up Rally’s Real-Time Audit Log” in the Rally Training 

Manual.

Problem: Resolution Steps:
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Rally displays an eCM 
warning message

1. An eCM Missing message means that the eCM was not 
inserted into the USB port within 20 seconds of the attempt to 
read the first MBB. Insert the eCM and click Retry.

2. An eCM PIN Failed 
message warns that the 
PIN entered is not correct 
for this eCM. Click OK 
and enter the correct PIN.

After five failed attempts the 
“Too many invalid PIN attempts” 
message appears. Click OK. Exit 
Rally. Obtain the correct PIN. 
Open Rally and retry.

3. An eCM Error with a code 
number usually means that the eCM is corrupt. Click OK and try 
another eCM written for this election.

4. An eCM Mismatch message means the key ID does not match 
the election. Click OK and try another eCM written for this 
election.

5. A Multiple eCMs message indicates that there is more than one 
eCM inserted into the USB ports on the PC. Remove all but one 
eCM and click Retry.

Problem: Resolution Steps:
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Notes:
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Appendices

Appendix A: Glossary

Term: Definition:

Abandoned Ballot A ballot that the voter did not cast into the ballot box before leaving the polling 
place. On an eSlate, this is a ballot that the voter did not cast by pressing the 
CAST BALLOT button and the voter is not present. Local election rules dictate 
dispensation of an abandoned ballot.

Absentee Ballot An official ballot issued to a voter who will be "absent" from the polling place on 
Election Day. 

Absentee Voting A voting method by which people can cast their ballots without going to the 
polling place on Election Day. Early Voting is sometimes referred to as 
"Absentee-in-person," and by-mail voting is sometimes referred to as 
"Absentee-by-mail." 

Access Code The four-digit number given to each voter that indicates to the eSlate system 
which precinct and ballot style to display to the voter on the eSlate voting unit. 
The Access Code is printed on a slip of paper printed on the JBC.

Access Code 
Status Report

A JBC report that is printed on-demand. It lists the number of Access Codes 
issued, voted, expired, canceled, and active.

Access Code 
Summary

A JBC report that is printed with the “Tally” report when polls are closed on 
Election Day. It lists the number of Access Codes issued, voted, expired, and 
canceled. 

Americans with 
Disabilities Act 
(ADA)

A 1990 federal act (Public Law 101-336) that established comprehensive 
standards for the treatment of persons with disabilities in employment, public 
accommodations, and other programs, including those operated by state and 
local governments.

ATA Advanced Technology Attachment; a disk drive implementation that integrates 
the controller on the disk drive itself.

Audio Card Used in a DAU eSlate, the PC card that contains the audio prompt recordings 
for an election. Formerly also called a “DAU Card”.

Audit Log, Audit 
Trail, Audit Report

Recorded information that allows elections officials to view the steps that 
occurred on the equipment included in an election to verify or reconstruct the 
steps followed without compromising ballot or voter secrecy. 

Authentication The verification of the identity of a person or process. In a communication 
system, authentication verifies that messages really come from their stated 
source, like the signature on a (paper) letter.

Ballot Box, eScan A secure receptacle for the eScan that collects scanned paper ballots and that 
has an emergency compartment for temporary storage of voted ballots in case 
the eScan is disabled.
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Ballot Box 
Security Seal

The seal attached to the MBB door on a JBC or eScan to secure the installed 
MBB. Also, the seal attached to the lid/receptacle junction of the eScan ballot 
box.

Ballot Code A unique number assigned to either a provisional ballot or an Early Voting 
retrievable ballot to enable swift retrieval of that ballot from the Hart Voting 
System Tally application by election officials.

Ballot Format The arrangement of the ballot created in BOSS. Ballots may be formatted for 
the eSlate or for Ballot Now.

Ballot 
Instructions

Instructional text that appears at the top of the ballot. There are two separate 
types of Ballot Instruction text: (1) eSlate and (2) Ballot Now. There is also 
separate audio instruction associated with the eSlate ballot instruction.

Ballot Key The unique alphanumeric identifier associated with each VBO cast vote record. 
This identifier aids in reconciling votes in case of a manual recount.

Ballot Now ™ The Hart Voting System software application that prints paper ballots on 
demand and then digitally images the voted ballots to save for delivery to Tally.

Ballot Now Image 
Processor

Ballot Now Image Processor (BNIP) is an application that runs in parallel with 
Ballot Now. After scanning ballots, BNIP processes ballot images.

Ballot Origination 
Software 
System™ (BOSS)

The software application used to build an election database and create ballot 
styles. BOSS is used to write the MBB, Audio, Solo, and Demo cards used in 
Hart Voting System equipment.

Ballot Style One of any number of specific ballot configurations issued to the appropriate 
precinct. At minimum, ballot styles differ from one another in content. They may 
also differ in size of type, in language used, or in method of presentation (e.g., 
visual or audio).
A ballot with a unique collection of contests to be used in the election. Every 
precinct’s (or split precinct’s) ballot is linked to one ballot style and there may be 
several precincts with the same ballot style. The ballot style information is 
carried on the MBB. A ballot style barcode is printed on the ballot.

Ballot Text Instructional text embedded in the ballot. Ballot Text is often used to identify a 
section of the ballot.

Bar Code A printed horizontal strip of vertical bars of varying widths, groups of which 
represent decimal digits.  In the Hart Voting System, bar codes are required in 
order for paper ballots to be correctly scanned. Ballot Now uses bar codes to 
represent a ballot page’s election identifier (ID), party ID, language ID, precinct 
ID, sheet ID, serial number (if applied), page number, ballot type, and duplex 
code.

Card Device The PC-card drive for reading and writing Hart Voting System data and audio 
cards.

Cast Vote Record 
(CVR)

An anonymous record of the contest options that a voter selected on his/her 
cast ballot. In the Hart Voting System, Cast Vote Records are stored in 
electronic format. One Cast Vote Record is equivalent to one ballot.

Term: Definition:
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Challenged Ballot Terminology and rules for “challenged ballots” or “challenged voters” vary by 
state. In general, a challenged ballot results when a voter’s right to cast a ballot 
in a certain jurisdiction is challenged for various procedural reasons. If the 
challenge stands, the voter may, in most cases, vote provisionally.

Contest A choice to be made on the ballot; a race. Contest types include offices, issues, 
referendums, propositions and questions.

Credentials Authentication information that enables access to operations in the system or 
associated databases. Credentials typically include user IDs and passwords.

Cumulative 
(Access Code) 
Summary

A summary on the JBC “Suspend Report” or “Daily Detail Report” that lists the 
Access Codes issued, voted, expired, and canceled for the entire session of 
Early Voting.

Cumulative Voting The votes for each candidate in an office contest are replicated as many times 
as the number of valid choices.

Cyclic 
Redundancy 
Check

A continuous test of each transfer of data within a system to ensure that the 
data received at the end of the transfer is the same as the data originated by 
the source.

(Daily) Detail 
Report

A report that the JBC or eScan prints when the polls at an Early Voting site are 
suspended. This report identifies the number of ballots cast per precinct.

Daily (Access 
Code) Summary

A summary on the JBC “Suspend Report” and “Daily Detail Report” that lists the 
Access Codes issued, voted, expired, and canceled for only the current day of 
Early Voting.

Daisy Chain Items connected in a series. The eSlates are daisy chained, one to another, 
with one plugging into the JBC.

Damaged Contest In Ballot Now, a mark requiring resolution because the option box has been 
erased or partially erased (damaged). A damaged contest may be resolved for 
voter intent or confirmed. If confirmed, a damaged contest will register as no 
choice for that selection. This may result in fewer selections than allowed for 
that contest; i.e., an undervote.

Database A storage point for information (data).

Demo Card An ATA memory card that contains both ballot and audio data for use in a 
Demonstration eSlate.

Demonstration 
eSlate (Demo)

An eSlate set up for voter education purposes, to allow voters to practice using 
the eSlate buttons and interface (including headphones and adaptive devices, if 
desired) on a functioning unit that cannot record votes. A Demonstration eSlate 
does not require a JBC in order to display ballots because it uses a special ATA 
memory card that contains both ballot and audio data. Demonstration eSlates 
are also known as “demo units.”

Digital Signature An encrypted digital code appended to data, making it possible to require 
authentication before allowing access to that data. 

Direct Record 
Electronic (DRE)

The election industry term for an electronic machine at which a voter can view, 
vote, and cast a ballot.

Term: Definition:
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Disabled Access 
Unit™ (DAU)

An eSlate that includes accessory components so that disabled persons can 
vote independently and privately. DAU eSlates include a module that accepts 
audio cards so that voters can listen to the ballot with headphones. DAU 
eSlates also have jacks for tactile input switches or “sip and puff” devices so 
that voters with limited mobility have alternatives to the SELECT wheel.

District A selection of precincts and/or split precincts that determine a voting group.

Duplicate Ballot During scanning, if serial numbers were printed on ballots, Ballot Now will 
search the database for an identical ballot serial number every time a ballot is 
scanned, and disallow the ballot if it is a duplicate.

Duplex Two-sided. In Ballot Now ballots are printed and scanned on both sides of the 
ballot sheet. The eScan scans both sides of the ballot sheet.

Early Voting In the Hart Voting System, the term for votes cast in-person prior to Election 
Day. Nomenclature for “Early Voting” varies from state to state in the U.S.A. 
(Absentee In-Person, Absentee Walk-In, etc.). Totals are not available from the 
polling place during the Early Voting period (i.e., no “Tally” report available).

Early Voting 
Retrievable Ballot

Ballots cast on the eSlate at Early Voting polling places that can be retrieved by 
Ballot Code from the Tally tabulation application by election officials. The Ballot 
Code is printed on the Retrieval Stub for an Early Voting retrievable ballot. A 
checkbox in BOSS must be selected in order to identify eSlate ballots cast 
during Early Voting as retrievable.

eCM eSlate Cryptographic Module; a highly secure peripheral USB device provided 
by Hart InterCivic. The eCM contains the signing key, the key ID, and the eCM 
PIN required to perform certain functions in the Hart Voting System 
applications.

eCM Manager The Hart InterCivic software application that manages approved security 
functions for use in the Hart Voting System. eCM Manager is used to create a 
signing key, and then write the signing key, key ID and eCM PIN to the eSlate 
Cryptographic Module (eCM).

eCM PIN eSlate Cryptographic Module Personal Identification Number; a password 
selected by the jurisdiction system administrator before any signing keys are 
written. This PIN is used to access functions requiring the eCM.

EDX Election Definition XML (eXtensible markup language); a format for election 
information data exchange.

Election 
Assistance 
Commission 
(EAC)

An independent federal commission that serves as a national clearinghouse 
and resource for the compilation of information and review of procedures with 
respect to the administration of federal elections.

Election ID An election identification code that is unique for every election. The election ID 
is used internally by the software applications.

Term: Definition:
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Election 
Identification 
Report

A report that the JBC or eScan prints when the polling place ID is selected. The 
report contains the current date and time, jurisdiction name, election name, 
election date, polling place, and number of precincts enabled for the polling 
place. For Election Day, shows the name of all precincts enabled for the polling 
place.

Election 
Management 
System (EMS)

A set of processing functions and databases within a Voting System that define, 
develop and maintain election databases; perform election definition and setup 
functions; format ballots; count votes; consolidate and report results; and 
maintain audit trails.

Encryption Any procedure used in cryptography to convert plaintext into ciphertext 
(encrypted message) in order to prevent any but the intended recipient from 
reading that data.

eScan™ Hart InterCivic’s precinct paper ballot scanning device. A  paper ballot printed 
from Ballot Now can be scanned and recorded on this device.

eSlate® Hart InterCivic’s direct record electronic (DRE) voting device. An electronic 
ballot can be viewed, voted, and recorded on this device. 

Event In SERVO, a specific backup of a set of devices in SERVO. An Election MBB is 
required to create an Event. Each Event relates directly to either an Election or 
a Test Election.

FEC Federal Election Commission, an independent federal regulatory agency. 
Voting systems regulation formerly assigned to this body have been transferred 
to the Elections Assistance Commission (EAC).

Finalized In BOSS, the database status that prevents further data modification and 
writing of MBBs to make it available to Tally. In Tally, the database status that 
prevents further reading of votes from MBBs into Tally.

FireWire A personal computer and digital video serial bus interface standard offering 
high-speed communications and isochronous real-time data services. FireWire 
(also known as i.Link or IEEE 1394) can be considered a successor technology 
to the SCSI Parallel Interface. FireWire is capable of transfer speeds of up to 
400 megabits per second.

Firmware Computer programs (software) stored in read-only memory (ROM) devices 
embedded in the system and not capable of being altered during system 
operation. For purposes of applying the Standards, firmware is considered a 
form of software.

Flash Memory Reprogrammable, read only memory that is used in PC cards or MBBs. Flash 
Memory does not require continuous electric power to operate. It is a system 
that can store more data and work faster than a traditional floppy disk.

Fractional 
Cumulative
Voting

A voter selects at least one candidate in a contest that allows votes for multiple 
options, but selects fewer than the number of options allowed. The unvoted 
options that were allowable are distributed equally to the voted options.

Functionality Test Testing of hardware functionality (e.g., testing to see that an eSlate button 
responds when pressed).

Term: Definition:
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Fusion™ A supplemental Hart Voting System software application used to integrate data, 
as from Tally and another voting system, and/or to provide custom reporting.

Hart Voting 
System

The full suite of Hart InterCivic’s election software and hardware products, 
covering everything from ballot creation to tabulation. Includes: BOSS, Ballot 
Now, eScan, JBC, eSlate, Rally, Tally, utility products, and SERVO. Previously 
referred to as the ‘eSlate Electronic Voting System.’

Hash Algorithm that maps a bit string of arbitrary length to a fixed-length bit string. 
Approved hash functions satisfy the following properties: (a) it is 
computationally infeasible to find any input that maps to any prespecified 
output, and (b) it is computationally infeasible to find any two distinct inputs that 
map to the same output.

HAVA The Help America Vote Act, signed into law October, 2002. HAVA intends to 
assist states in the administration of federal elections and establishes 
“minimum standards for states and units of local governments with the 
responsibility for the administration of federal elections.”

Incomplete Ballot A multi-sheet ballot being scanned in a scan batch that has its first sheet, but is 
missing following sheets.

Infusion™ A supplemental Hart Voting System software utility used to extract data, as from 
another voting system or voter registration system, and/or to provide ballot data 
formatted for import into BOSS.

Initialized Report A report printed from the JBC and eScan any time the device is powered on. 
This report shows a timestamp, firmware version, and diagnostic test result. A 
self-diagnostic test is run on the system, and the result is indicated as 
“**PASS**” on the report.

Judge’s Booth 
Controller™
(JBC)

The control unit of the eSlate system, through which a poll worker distributes 
electronic ballots to the eSlate and DAU eSlate.

Jurisdiction A precinct or group of precincts managed by a single organization.

Key GUID Key Globally Unique Identifier. A unique, system-generated value assigned to 
each signing key in the eCM Manager.

Key ID A user-selected identification number that prompts the eCM Manager 
application to generate a new 128-bit encrypted signing key. Allowed values are 
from 1 to 99.

Locked Ballot In Ballot Now, a ballot that is currently checked out in the resolve process for 
editing by a user.

Logic and 
Accuracy Test 
(L & A or LAT)

In the context of an election, a test to check the accuracy of a piece of voting 
equipment. An LAT is accomplished by feeding test ballots for which the results 
are already known (i.e., a “test deck”) through the ballot counting system and 
comparing the results with the expected results. If an error occurs (i.e., the 
actual test deck count does not match the expected count), then the problem is 
investigated and corrected, and the test is repeated.

Term: Definition:
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MBB, Election An MBB used to collect votes for an election. The Election MBB can only 
contain information from Election ballots.

MBB, Test An MBB used for test purposes when validating the eSlate system before an 
election. The Test MBB can only contain information from Test ballots.

Mobile Ballot 
Box™ (MBB)

A PC card that holds all of the ballot information for the Hart Voting System. An 
MBB is placed in the JBC unit, the eScan device, and/or in the Ballot Now 
computer. Cast Vote Records are also stored on MBBs, which are read into 
Tally. Audio is not stored on an MBB.

Network 
Configuration 
Report

A report printed on the JBC after booths are assigned. The report contains the 
serial number, software version, PUB count, and PVT count for the JBC and 
each eSlate unit.

Non-partisan 
Office

An elected office for which candidates run independent of political party 
affiliation.

Orphan Ballot A multi-sheet ballot being scanned in a scan batch that has missing leading 
sheets.

Overvote The generally prohibited practice of voting for more than the allotted number of 
options for a given contest. 
On the eSlate it is not possible to overvote.

Party A political party, for example Democratic or Republican.

PC Card An information storage device that is about the size of a credit card. Similar to a 
USB memory stick. It is also called a “PCMCIA” card. In the Hart Voting System 
it is called a Mobile Ballot Box (MBB), an audio card, or a demo card.

Persistence A property of a programming language where created objects and variables 
continue to exist and retain their values between runs of the program.

Polling Place The area within the polling location where voters cast ballots. 
Often a single polling place supports several precincts.

Polls Closed 
Report

Report printed by the JBC, VBO and/or eScan when the polls are closed. This 
report includes a timestamp indicating the date and time printed.

Polls Open Report Report printed by the JBC, VBO and/or eScan when the polls are opened. This 
report includes a timestamp indicating the date and time printed.

Poll Worker 
Button

A button, located on the back panel of the eScan device, used to access poll 
worker and administrator functions.

Precinct A jurisdiction subdivision for election purposes.

Precinct Voting 
System
(PVS)

A legacy term for those components of the Hart Voting System that are used for 
election activities at individual polling places. 

Provisional Ballot A ballot provided to individuals who claim they are eligible to vote but whose 
eligibility cannot be confirmed when they present themselves to vote. Once 
voted, such ballots are not included in the tabulation until after the voter’s 
eligibility is confirmed.

Term: Definition:
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Provisional Ballot 
Stub

A report that prints below the Access Code when a provisional ballot is 
requested during the “Add Voter” procedure on the JBC. This stub includes the 
Ballot Code used for ballot retrieval during the tabulation process. The stub 
must be separated from the Access Code and kept for ballot tracking purposes 
for this unique type of ballot.

Provisional 
Parsing

The process of selectively reporting on a provisional ballot only those contests 
in which a provisional voter is eligible to vote, based on his/her precinct of 
residence. Provisional parsing becomes necessary when the provisional voter 
has cast a ballot outside of his/her correct precinct, and the voted ballot style 
includes contests for which the voter is not eligible to vote. When the Tally 
software application is installed, users have the option to enable a provisional 
parsing interface. If enabled, once the Tally application has selectively identified 
(i.e., “parsed”) those contests on a provisional ballot for which voted options 
shall be reported, election officials can choose how to report results: cast votes 
may be associated with the original precinct in which the provisional ballot was 
actually cast, or they may be reassigned to the voter’s correct precinct. 

Provisional Voter A voter whose eligibility is yet to be determined at a given polling place. A 
provisional voter is allowed to vote on a “provisional ballot” under conditions set 
by state election law. Because the voter is “provisional”, his/her ballot must be 
retrievable by election officials under certain conditions that vary from state to 
state.

PUB (Public) 
Count

Also called the “ballot counter”. A six-digit number, shown on the JBC and 
eScan configuration reports and Polls Open screen, and in the Ballot Now 
window, that indicates how many votes have been counted, and CVRs 
recorded, on that machine for the current election. The public count of a device 
is reset to “zero” during warehouse operations between elections.

PVT (Private) 
Count

A six-digit number, shown on the JBC and eScan configuration reports and 
Polls Open screen, and in the Ballot Now window, that indicates how many 
ballots have been cast on that machine in its lifetime. CVRs are not associated 
with the private counter. The private counter cannot be zeroed.

Rally™ The Hart Voting System application that reads, stores, and transfers CVRs via 
local area network or modem connection to a PC running the Tally application.

Replacement 
Ballot

A ballot that is designated by the election authority to be a replacement for a 
spoiled ballot.

Resolution The Ballot Now task of assigning the voter’s intent to votes on ballots that 
contain an undervoted contest, an overvoted contest, or a contest with a 
selected write-in. Resolution may also exclude a completely blank ballot or a 
damaged ballot.

Sample Ballot A ballot printed as a sample of the real election ballot. Sample ballots contain a 
special barcode which prevents them from being included as a CVR in an MBB.

Scan Batch A group of ballot sheets to be scanned. Each scan batch has certain number of 
sheets. Ballot Now assigns and prints a sequence number when the ballots are 
printed. The user can assign comments to a scan batch in the Scan Ballots 
window prior to scanning the batch of ballots.

Term: Definition:
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Select Wheel The rotary wheel on the eSlate and DAU eSlate that allows a voter to navigate 
the ballot and highlight choices by turning the wheel.

Serial Number A barcode and/or human-readable number placed on the ballot stub and/or the 
sheets of a ballot that uniquely identifies the ballot in order to prevent duplicate 
scanning of paper ballots.

SERVO™ The eSlate application used as a System for Election Record Verification and 
Operations. This application is used for polling place equipment cast vote 
record backup, recovery, recount, and resetting.

Sheet In reference to Ballot Now paper ballots, one piece of paper printed on both 
sides, i.e., duplex. Ballot Now ballots can consist of no more than 9 sheets.

Signing Key A true 128-bit random number used to cryptographically protect data, making it 
possible to require authentication before allowing access to the data. In the Hart 
Voting System, the signing key is written to the eCM, JBCs, eScans, and MBBs.

Sip-and-Puff A voter’s personal input device that connects to the DAU eSlate in the disabled 
access jack. This enables disabled voters with extremely limited mobility to vote 
with a mouth-controlled device.

Split Precinct The smallest division of a precinct for election purposes.

Spoiled Ballot A ballot that has been rendered invalid by a voter who is still present at the 
polling place, making it necessary to give the voter a new ballot. With the 
eSlate, a ballot is spoiled if the voter gets the wrong ballot style, the wrong 
language, or is not on the DAU eSlate but needs to be.

SSL Secure Sockets Layer; a protocol developed by Netscape for transmitting 
private documents via the Internet. SSL works by using a private key to encrypt 
data that is transferred over the SSL connection.

Straight Party 
Voting

A voting method that presents a contest that allows selection of a single political 
party in order to automatically select candidates of that party in contests that 
allow straight party voting.

Suspend Report A JBC or eScan report that automatically prints when polls are suspended in 
Early Voting. For the JBC, the report lists the PUB count and PVT count of the 
JBC and eSlate units, a Daily (Access Code) Summary, and a Cumulative 
(Access Code) Summary, as well as a timestamp.

Tactile Input 
Switches

Also called “dual mode switches,” “jelly switches,” or “buddy buttons,” these red 
and green “paddles” enable voters with disabilities to vote without using the 
SELECT wheel and ENTER button on the eSlate. Voters without fine motor 
control may use these. The red tactile input switch allows voters to navigate 
through the ballot, similar to turning the SELECT wheel in a clockwise direction. 
The green switch is similar to pressing the ENTER button.

Tally™ The Hart Voting System tabulation software. After an election, the Tally software 
counts the votes on the MBB(s) and produces reports on those cast votes.

Term: Definition:
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Tally Report Tape An Election Day report that may be printed on a JBC or eScan after polls are 
closed. It includes the date, time, precinct, a tally of votes for each contest, and 
an Access Code or ballot summary. BOSS includes a setting for allowing, or 
disallowing, this report to be printed from the JBC or eScan after close of polls 
on Election Day.

TRANS Translation, Recording, and Audio Normalization System; an eSlate application 
for translating multi-language ballot text and for recording all audio (including 
English) to be imported into the BOSS database.

Undervote The practice of voting for less than the total number of election contests listed 
on the ballot, or of voting for less than the number of options allotted for a given 
contest. 

UPS Uninterruptible Power Supply.

USB Universal Serial Bus; an external peripheral interface standard for 
communication between a computer and other devices. In the Hart Voting 
System, an eCM connects to a USB port.

VBO Verifiable Ballot Option; the Hart Voting System VVPAT (Voter-Verified Paper 
Audit Trail) device that can be connected to the eSlate or Demonstration eSlate 
inside the voting booth in order to print a paper record of each ballot cast.

Voter Registration 
Computer

An electronic poll book sometimes known as a “thin client” or “VR Computer.”

VVPAT Voter-Verified Paper Audit Trail; Implemented in the Hart Voting System by the 
VBO (Verifiable Ballot Option) device.

WAV file A file format (.wav) used for storing digital audio. TRANS audio is stored in .wav 
file format.

Write-in A name of a candidate entered by the voter in order to vote for a candidate that 
is not listed on the ballot.

Write-in, certified A candidate that has been certified by the election authority as being a valid 
write-in candidate for the election.

Write-in Voting A means to cast a vote for an individual not listed on the ballot.

XLIFF XML Localization Interchange File Format. A file type (.xlf) used by BOSS and 
TRANS for language text translation.

XML eXtensible Markup Language. A structured, extensible, text-based data 
definition and data exchange format. TRANS uses an .xml file as a manifest, or 
index, to associated audio .wav files. 

Zero Tape Report A JBC or eScan report that prints out when polls are opened on the first day of 
Early Voting and on Election Day. This report lists the timestamp, the number of 
precincts at the polling place, the contests and candidates on the ballot, and 
verifies that the number of votes for each candidate or option is zero.

Term: Definition:
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Appendix B: Information, Confirmation, Error, and Warning Messages

Type of 
Message: Explanation: Example:

Information Informs about an 
operation
Includes an 
information icon
Includes an OK 
button

Confirmation Asks user to confirm 
an action, particularly 
when the action 
cannot be reversed
May include text from 
the command 
performed
Includes a question 
mark icon
User responds with 
Yes or No

Error First statement in 
error identifies the 
problem
Second statement 
may inform user of 
required action
Includes an error icon
Includes an OK 
button

Warning Appears when the 
user must double-
check a command
May include text from 
the command 
performed
Includes a warning 
icon
Includes an OK 
button
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Notes:
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Appendix C: Hart Voting System Software User Tips

The following apply to ALL Hart Voting System programs.

Software Password, Certificate, and PIN Tips
Best Practices

Do not give out an administrator password, applicable either to the PC where the Hart Voting System 
software is housed, or to a Hart Voting System application itself.
Change every user ID, password, certificate, eCM key ID, signing key, and PIN(s) during PC 
acceptance and at regular intervals and in accordance with federal, state, and local guidelines.
The user currently logged in should stay at the computer while running the application and exit the 
application if s/he steps away from the PC.

Avoid Using

Any password you have used before
Any string of three characters repeated or reversed
Any character repeated more than twice
Your name or your initials
The computer or application user ID
The names of relatives, birthdays, phone numbers or the company name
The number for this year, last year or next year, or the three-character abbreviations for the months
Telephone number or car license plate numbers

Do Use

A combination of upper and lowercase letters
A password that is at least 6 - 12 characters long
A new password for every user at regularly scheduled intervals (e.g., annually or quarterly)
Random characters users will remember

Tips for a Secure Password, Certificate, or PIN

Use the first letters of the words in a memorable phrase.
Use a meaningless but easy-to-remember phrase.
Insert numbers into the phrase.
Note the password, certificate information, and/or eCM PIN, in a private and secure location.

Computer Security
Computers running Hart InterCivic software should be kept in locked spaces with limited access. 
Password-protected screen savers or other similar security measures should be applied.
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Software Features
Whichever button is shadowed/dotted inside a window is the button selected for activation with the 
keyboard Enter key.
Whichever character on a menu or button is underlined indicates that the function may be activated 
with the Alt key and that character. 

In a menu, an arrow facing to the right opens a pop-up menu, offering more choices.

In a dialog box, the arrow facing down opens a list box, offering more choices.

Per application, to view the version release number (N.N.N), go to the Help menu and click About.
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The following tips apply to specific software programs:
BOSS, Ballot Now, Tally, and SERVO: To highlight/select a list of items (e.g., precincts) that are 
consecutive, use Shift + Click.

1. Click the first item once. 
2. Hold down on Shift. 
3. Click the last item once. 
4. Release Shift.

BOSS, Ballot Now, Tally, and SERVO: To highlight/select a list of items (e.g., precincts) that are not 
all consecutive, use Ctrl + Click. 

1. Click the first item.
2. Hold Ctrl.
3. Continue to click items, holding Ctrl, until you have selected all targeted items.
4. Release Ctrl.

Tally Copy and Paste:

1. Select the item(s) you wish to copy. 
(To select, click and drag over the item to highlight it.)

2. Press Ctrl and then C (the shortcut key for copy).
3. Make certain the cursor is blinking in the field you wish to paste into and press Ctrl + V to paste.
4. You can copy and paste from one field to another (e.g., in write-in candidate and alias fields) by 

using Ctrl + a shortcut key (C,X,V), or by using standard right-click functionality.

Tally: Test and Election mode MBBs are read into separate databases. This protects database 
integrity. 
• Only one opened Election mode database may exist for a unique BOSS database. 

Tally: A jurisdiction can opt to read unvoted MBBs that were written as spares into Tally. This allows 
the jurisdiction to account for all MBBs written for the election. Reports and the audit trail will reflect 
that MBBs are accounted for.
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Notes:



6300-005 62C Tally Training Manual

© Hart InterCivic, Inc. Appendix D: Backing Up Election Databases Page 115

Appendix D: Backing Up Election Databases

What Data to Back Up

The following database folders should be backed up to CD1:

eCM Manager; *.eCM file created with the Save File function
BOSS; Numbered folder with BossData.db and BossData.cfg files
Ballot Now Test; Numbered folder with the election I.D. followed by a “T” (e.g., 023T), in addition to 
the BNsecurity.db and BNsecurity.cfg files in the “Ballot Now” folder
Ballot Now Election; Numbered folder with the election I.D. (e.g., 023), in addition to the 
BNsecurity.db and BNsecurity.cfg files in the “Ballot Now” folder
Rally;  “Database” folder with the Mbbtrans.db and Mbbtrans.cfg files
Tally Test; Numbered folder with the TallyData.db and TallyData.cfg files
Tally Election; Numbered folder with the TallyData.db and TallyData.cfg files
SERVO; “Database” folder with the ServoData.db and ServoData.cfg files.

Locations of Election Database Folders for Backup:

eCM Manager; after clicking Save File, use standard Windows navigation to navigate to a folder 
named for the election and to name the .eCM file.
BOSS; C:\boss\Database\YearMonthDay-HourMinuteSecond (12 digits)
Ballot Now; C:\Program Files\Hart Intercivic\Ballot Now\### (three-digit Election I.D.)
• C:\Program Files\Hart Intercivic\Ballot Now\BNsecurity.db
• C:\Program Files\Hart Intercivic\Ballot Now\BNsecurity.cfg
Rally; C:\Program Files\Hart InterCivic\Rally\Database
Tally; C:\Program Files\Hart InterCivic\Tally\Database\YearMonthDay-HourMinuteSecond (12 digits)
SERVO; C:\Program Files\Hart InterCivic\SERVO\Database

Naming conventions for folders and CD files:

Name each application’s backup folder with the application, election, type of election, and date of 
election. (Example: BOSSgeneral_11.02.04)
Name the CD within the character limits for the CD creator application. The jurisdiction, election, and 
election date should be included. (Example: Smith_gen11.2.04)

How and When to Back Up Data

BOSS, Tally, and Rally include backup or archive functions within the user interface. An administrator-
level user may use this function to back up the database and configuration files to a user-defined 
directory on the PC. Database and configuration files should always be saved to folders named for the 
election, the time and date, and the status of the database.

All application databases can be backed up by saving the folders indicated in the “Locations of Election 
Databases” section to a user-defined directory on the PC and/or directly to CD. These folders should 
always be saved to a directory (folder) named for the election, the time and date, and the status of the 
database.

Back up the .eCM file:
• Immediately after creating eCMs for the election.
Back up the numbered BOSS database folder (or use the Archive function in BOSS):
• Immediately before exporting text for translation
• After importing translated text and audio
• After completing all proofreading and before generating the ballot

1. If a database is too large for backup to CD, another medium will be required.
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• After generating the ballot and writing media, but before finalizing the database
• After finalizing the database.
Back up the numbered Ballot Now database folder and BNsecurity.db and BNsecurity.cfg files:
• After closing the election in Ballot Now, at minimum.
Back up the numbered Tally database folder (or use the Backup function in Tally):
• After each instance of creating printed and exported reports for public use (e.g., media outlets)
• After processing absentee by-mail MBBs on Election Day
• After processing Early Voting MBBs
• After each instance of creating printed and exported reports for public use (e.g., media outlets) 

on Election Day
• After processing absentee by-mail late mail MBBs after Election Day
• Before resolving write-in votes
• Before resolving provisional ballots
• Before finalizing
• After finalizing
• Immediately after Canvassing.
Back up each Rally station “Database” folder (or use the Archive function in Rally):
• After processing all MBBs and printing and exporting final reports and before resetting the Rally 

database (including before resetting the Rally database as an emergency procedure).
Back up the SERVO “Database” folder:
• After inventorying equipment with SERVO pre-election
• After backing up equipment post-election
• On the “master” SERVO PC after combining events into one “master” event for an election, if 

applicable.

Backing up to CD

In order to back up to a CD, use the CD creator application supplied with the Hart InterCivic PCs. Refer 
to the online help for the specific steps for creating a CD.

Hart InterCivic suggests using a CD-R rather than a CD-RW. A CD-R is a one-time use—you can only 
write to it once, and then you can only read off of it. A CD-RW is readable/writable, and can be used 
multiple times like a floppy disk—you can read and write to it as often as you want. CD-Rs are 
inexpensive, and the data on the CD itself cannot be changed. This makes the CD-R option a good 
media for backing up data. 

After creating a CD, always navigate to the CD drive and verify that the CD contains all of the data 
intended for backup.
Label the CD with the Jurisdiction, Election Title, Date, and eSlate application.
File the CD in a secure location.
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Appendix E: Windows Tally and Rally LAN Setup
If using a Local Area Network (LAN) connection to communicate from Tally to Rally stations, Tally must 
be set up to communicate with the Rally stations, and Rally stations using LAN must be set up to accept 
Tally communications. All PCs must have unique IP addresses. The steps illustrated here outline setting 
up the proper LAN connections in a Windows 2000 environment after the LAN lines have been 
physically connected to the PCs. The actual windows that display may vary slightly per PC.

  Note:
Tally can be set up to communicate with some Rally stations via LAN, and others via modem.

LAN Setup: At the Tally PC and at each LAN Rally PC

1. Close all applications.
2. Go to the PC Control Panel and double-click Network and Dial-up Connections.
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3. Right-click the network card (“Local Area Connection” in this illustration), and select Properties.

4. Verify that the Internet Protocol (TCP/IP) network component is checked, highlight it, and click 
the Properties button. 

5. Select the Use the following IP address radio button, enter the Tally or Rally PC’s unique IP 
address, and press Tab.

6. Click the Subnet mask field, and it will autofill.
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7. Click OK.

8. Click OK and exit the Control Panel.

9. Repeat for each Tally and Rally PC. All PCs must have unique IP address. This concludes LAN 
setup for Tally and Rally PCs. Next, set up user permissions, Tally’s Rally Configuration 
settings, and Rally’s Options settings.

  See:
  See:“Tally User Permissions and Certificate” on page 15. 

“Coordinating Definitions in Tally and Rally” on page 63.
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Notes:
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Appendix F: Windows Tally and Rally Modem Setup
If using a modem connection to communicate from Tally to Rally stations, Tally must be set up to dial out 
to the Rally stations, and the Rally stations using modems must be set up to accept incoming calls. All 
PCs must have unique IP addresses. The steps illustrated here outline setting up the proper modem 
connections in a Windows 2000 environment after the modems have been physically connected to the 
PCs. The actual windows that display may vary slightly per PC.

  Note:
Tally can be set up to communicate with some Rally stations via LAN, and others via modem.

Modem Setup Part 1: At the Tally PC Using a Modem

1. Close all applications.
2. Install a modem that is compatible with the Tally PC.
3. Go to the PC Control Panel and double-click Phone and Modem Options.
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4. Click the Modems tab.

5. Select the modem name and click Properties.
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6. Verify that the Maximum Port Speed is set to at least 28 bps, and that it is set for the same 
speed as the incoming connection on the Rally PCs (115200 is the recommended speed).

7. Click OK.

8. Click OK and exit the Control Panel.
9. Continue to set up each Rally PC using a modem.

  See:
  See:“Modem Setup Part 2: At each Rally PC Using a Modem” on page 124.
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Modem Setup Part 2: At each Rally PC Using a Modem

Conduct the following steps at each Rally PC where a modem will be used for the Tally-Rally connection.

1. Close all applications.
2. Go to the PC Control Panel and select Network and Dial-up Connections.
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3. Double-click Make New Connection.

4. Click Next.
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5. Select Accept incoming connections, and click Next.

6. Select the checkbox for the modem being used for incoming connections, and select the 
Properties button.
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7. Verify that the Port speed is set to at least 28 bps (all Tally and Rally PCs must be set to the 
same modem speed; 115200 bps is recommended), and click OK.

8. Click Next.
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9. Select Do not allow virtual private connections, and select the Next button.

10.  Leave the “Allowed Users” as is, and select the Next button. 

11.  Verify that the Internet Protocol (TCP/IP) network component is selected (checked), highlight it, 
and select the Properties button.
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12.  Deselect (uncheck)
> Allow callers to access my local area network.

13.  Select Specify TCP/IP address
> EACH RALLY PC SHOULD USE THE SAME IP ADDRESS RANGE, as illustrated below.

14.  Select Allow calling computer to specify its own address (check).
15.  Click OK.

16.  Click Next.
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17.  Name the connection, and select the Finish button. 

18.  The new connection appears in the Network and Dial-up Connections window. Close all 
windows.

19. Repeat for each Rally PC using a modem connection. This concludes modem setup for Tally and 
Rally PCs. Next, set up user permissions, Tally’s Rally Configuration settings, and Rally’s 
Options settings.

  See:
  See:“Tally User Permissions and Certificate” on page 15. 

“Coordinating Definitions in Tally and Rally” on page 63. 

  Note:
After testing the Tally/Rally connection, check the password policy for the Tally modem user 
name on each Rally PC to make certain that the maximum password age does not expire before 
the election event.
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Appendix G: Hart Voting System Recount Procedures

Overview

This appendix outlines the procedures for performing recounts with the Hart Voting System. Recount 
operations should be performed by advanced PC users. Recount databases in Tally should follow 
database naming conventions, including identification with “RECOUNT” wording in the database 
description. 

  See:
  See:“Tally Database Management” on page 9.

Several types of recount are documented here:

1. Full Recount
1.1  Tally Full Recount
1.2  SERVO MBB Full Recount
1.3  SERVO Manual Full Recount
1.4  VBO Report and Paper Ballot Manual Full Recount

2.  Precinct-Specific Recount
2.1  Tally Precinct-Specific Recount
2.2  SERVO MBB Precinct-Specific Recount
2.3  SERVO Manual Precinct-Specific Recount
2.4  VBO Report and Paper Ballot Manual Precinct-Specific Recount

3. Contest-Specific Recount
3.1  Tally Contest-Specific Recount
3.2  SERVO MBB Contest-Specific Recount
3.3  SERVO Manual Contest-Specific Recount
3.4  VBO Report and Paper Ballot Manual Contest-Specific Recount

4. Recount of a Percentage of the Cast Ballots or Precincts
4.1  Tally Percentage Recount
4.2  SERVO MBB Percentage Recount
4.3  SERVO Manual Percentage Recount
4.4  VBO Report and Paper Ballot Manual Percentage Recount

5. Recount of a Polling Place
5.1  Tally Polling Place Recount
5.2  SERVO MBB Polling Place Recount
5.3  SERVO Manual Polling Place Recount
5.4  VBO Report and Paper Ballot Manual Polling Place Recount
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1. Full Recount 
1.1  Tally Full Recount

Steps: Details:

1.1.1  After the election has been run in 
Tally, back up the original numbered 
Tally database folder to CD.

File path to the Tally database folder is:
C:\tally\Database\TimestampFolder

  Note:
Optional: Archive the database within 
Tally. This creates duplicate database 
and database configuration files in a 
separate location on the PC.

1.1.2 If you haven’t already done so, 
finalize the original Tally database.

A NEW status Election mode database cannot 
reside on the PC with the original Tally database 
from the same election, unless the original 
database has a “Finalized” status.

1.1.3 Click the Election Databases 
Quick Link and click New.

1.1.4 Copy the original BOSS database 
into Tally, setting parameters 
consistent with those set in the 
original Tally database.

Split Precinct processing
Reporting Options
Tabulation Start Time

1.1.5 Name/describe the new Tally 
database “RECOUNT Full Tally 
<Election Name Date>”.

1.1.6 Click the Election Databases 
Quick Link, highlight the recount 
database name, and click Select.

1.1.7 Set parameters for write-in 
processing.

Go to the Options menu and click the 
Reporting Options tab.

1.1.8 Print a “Zero Report.” Click the Reporting Quick Link and select the 
“Cumulative Report.”

1.1.9 Process MBBs. Re-read all original MBBs.

1.1.10 Process Early Voting Retrievable 
Ballots as in original Tally database, 
if applicable.

1.1.11 Print Reports.

1.1.12 Process Provisional Ballots as in 
original Tally database, if applicable.

Also parse provisional ballots as in original Tally 
database, if applicable.

1.1.13 Print reports.
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1.1.14 Perform Write-in Resolution as in 
original Tally database, if applicable.

1.1.15 Print reports.

1.1.16 Process Vote Adjustments as in 
original Tally database, if applicable.

1.1.17 Print Reports.

1.1.18 Finalize the recount election.

1.1.19 Print official reports. Click the Reporting Quick Link and select the 
reports you want to print.

1.1.20 Save the recount database to CD.

Steps: Details:
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1. Full Recount
1.2  SERVO MBB Full Recount (via Tally)

Steps: Details:

1.2.1  After the election has been run in 
Tally, back up the original numbered 
Tally database folder to CD.

File path to the Tally database folder is:
C:\tally\Database\TimestampFolder

  Note:
Optional: Archive the database within 
Tally. This creates duplicate database 
and database configuration files in a 
separate location on the PC.

1.2.2 If you haven’t already done so, 
finalize the original Tally database.

A New status Election mode database cannot 
reside on the PC with the original Tally database 
from the same election, unless the original 
database has a “Finalized” status.

1.2.3 After the election, back up polling 
place equipment using the SERVO 
application.

Back up eScans, JBCs and eSlates, as 
applicable.

1.2.4 Using SERVO, build JBC recount 
MBB(s) with blank Election mode 
MBB(s) from the original BOSS 
database.

One MBB can contain approximately 
1.2 million ballots.
Option 2: With SERVO, build eSlate recount 
MBB(s) with Election MBB(s) from the 
original BOSS database.

1.2.5 Using SERVO, build eScan recount 
MBB(s) with blank Election mode 
MBB(s) from the original BOSS 
database.

One MBB can contain approximately 
1.2 million ballots.

1.2.6 Click the Tally Election Databases 
Quick Link and click New.

1.2.7 Copy the original BOSS database 
into Tally, setting parameters 
consistent with those set in the 
original Tally database.

Split Precinct processing
Reporting Options
Tabulation Start Time

1.2.8 Name/describe the new Tally 
database “RECOUNT Full SERVO 
<JBC or eSlate> <Election Name 
Date>”.

1.2.9 Click the Election Databases Quick 
Link, highlight the recount database 
name, and click Select.

1.2.10 Set parameters for write-in 
processing.

Go to the Options menu and click the 
Reporting Options tab.

1.2.11 Print a “Zero Report.” Click the Reporting Quick Link and select the 
“Cumulative Report.”
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1.2.12 Read the JBC and/or eScan recount 
MBB(s) into Tally, as applicable.

Option 2: Read the eSlate recount MBB(s) 
into Tally, instead of the JBC recount 
MBB(s).
Do not read both the JBC AND eSlate 
MBBs, as they duplicate the same 
information. The situation will dictate which 
MBBs to read.
If JBC and eSlate recounts are both needed, 
they must read into separate Tally recount 
databases.

  Note:
If the election was conducted with Early 
Voting and Election Day as separate 
Events in SERVO, an MBB must be 
written for each Event.

1.2.13 Read the original Ballot Now MBB(s) 
into the recount database, if 
applicable.

Or rescan Ballot Now ballots into a new 
Ballot Now PC, using a blank Election mode 
MBB from this election. 
Resolve EXACTLY as with the original Ballot 
Now database. In order to accomplish this, 
use the Ballot Now “Scan Batch” and “Audit 
Trail” reports to duplicate resolution 
decisions.

1.2.14 Process Early Voting Retrievable 
Ballots as in original Tally database, 
if applicable.

1.2.15 Print Reports.

1.2.16 Process Provisional Ballots as in 
original Tally database, if applicable.

Also parse provisional ballots as in original Tally 
database, if applicable.

1.2.17 Print reports.

1.2.18 Perform Write-in Resolution as in 
original Tally database, if applicable.

1.2.19 Print reports.

1.2.20 Process Vote Adjustments as in 
original Tally database, if applicable.

1.2.21 Print Reports.

1.2.22 Finalize the recount election.

Steps: Details:
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1. Full Recount
1.3  SERVO Manual Full Recount

1.2.23 Print official reports. Click the Reporting Quick Link and select the 
reports you want to print.

1.2.24 Save the recount database to CD.

Steps: Details:

1.3.1 After the election, back up polling 
place equipment using the SERVO 
application.

  Note:
Early Voting equipment should be 
backed up to an Early Voting Event, and 
Election Day equipment should be 
backed up to an Election Day Event.

1.3.2 In SERVO, go to Reports/Votes By 
Precinct

1.3.3 Select the Event and Device (type). Print SERVO records for JBCs or eSlates 
only, if also counting eScan paper ballots.
If the election was conducted in Early Voting 
and Election Day modes, then perform this 
procedure for each.

1.3.4 Select all precincts. Highlight the first precinct in the list, hold the 
Shift key, and highlight the last precinct in the 
list.

1.3.5 Click OK.

1.3.6 Print.

1.3.7 Manually recount Cast Vote 
Records (CVRs) and Ballot Now and 
eScan paper ballots, as applicable.

Use a spreadsheet or paper form to keep track 
of votes.

Due to the high likelihood for human error 
using this recount method, the results may 
not match the original Tally reports, or Tally 
or SERVO electronic recounts. 

Steps: Details:
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1. Full Recount
1.4  VBO and Paper Ballot Manual Full Recount

Steps: Details:

1.4.1 After the election, remove VBO 
printouts from all eSlate booths, and 
store these printouts in a secure 
location.

1.4.2 Manually recount all VBO “Paper 
Verification Page Reports” that 
include the “Ballot Accepted” 
nomenclature. 

OR Collect this data via reading the 2-D bar 
code on each “Paper Verification Page 
Report” with a 2-D bar code scanner.
If comparing VBO “Paper Verification Page 
Reports” to SERVO reports, note that only 
JBC and/or eSlate device cast vote records 
will include the Ballot Key information to 
reconcile with VBO reports. (eScans do not 
include VBO devices.)

1.4.3 Manually recount Ballot Now and 
eScan paper ballots, as applicable.

Use a spreadsheet or paper form to keep track 
of votes.

Due to the high likelihood for human error 
using this recount method, the results may 
not match the original Tally reports, or Tally 
or SERVO electronic recounts. 
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2. Precinct-Specific Recount
2.1  Tally Precinct-Specific Recount

2. Precinct-Specific Recount
2.2  SERVO MBB Precinct-Specific Recount (via Tally)

Steps: Details:

2.1.1 Perform steps for a full recount with 
Tally.

  See:
  See:“Tally Full Recount” on page 132.

Use the original election MBBs.

2.1.2 Print the “Precinct Report” for 
specific precincts.

2.1.3 If necessary, create a custom report 
based on the Precinct Report:

2.1.4 Report Name: “Precinct X Results”
2.1.5 Based On: Precinct.rpt
2.1.6 Report Title: “Precinct X Results”
2.1.7 Name precinct in filter and select 

precinct
2.1.8 Select all contests
2.1.9 Open and print report
2.1.10 Repeat process for each precinct.

Steps: Details:

2.2.1 Perform steps for a Full Recount/
SERVO MBB Recount.

Use SERVO recount MBBs from either the JBCs 
or eSlates.

2.2.2 In Tally, print the “Precinct Report” 
for specific precincts.

2.2.3 If necessary, create a custom report 
based on the Precinct Report:

2.2.4 Report Name: “Precinct X Results”
2.2.5 Based On: Precinct.rpt
2.2.6 Report Title: “Precinct X Results”
2.2.7 Name precinct in filter and select 

precinct
2.2.8 Select all contests
2.2.9 Open and print report
2.2.10 Repeat process for each precinct.
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2. Precinct-Specific Recount
2.3  SERVO Manual Precinct-Specific Recount

Steps: Details:

2.3.1 After the election, back up polling 
place equipment with the SERVO 
application.

Back up eScans, JBCs and eSlates, as 
applicable.

2.3.2 In SERVO, go to Reports/Votes by 
Precincts.

2.3.3 Select the Event, Device (type), 
and Precinct(s).

Print SERVO records for JBCs or eSlates 
only, if also counting eScan paper ballots.
If the election was conducted in Early Voting 
and Election Day modes, perform this 
procedure for each.
Use the Ctrl key and click to highlight 
numerous precincts.

2.3.4 Click OK.

2.3.5 Print the report generated. SERVO will also export reports to a spreadsheet 
format with the export tool (envelope icon on 
report menu bar).

  Tip(s):
The Excel 5.0 extended export is a 
format that is simple to use.

2.3.6 Manually recount Ballot Now and 
eScan paper ballots from the 
targeted precincts, as applicable.

Use a spreadsheet or paper form to keep track 
of votes.

Due to the high likelihood for human error 
using this recount method, the results may 
not match the original Tally reports, or Tally 
or SERVO electronic recounts. 
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2. Precinct-Specific Recount
2.4  VBO and Paper Ballot Manual Precinct-Specific Recount

Steps: Details:

2.4.1 After the election, remove VBO 
printouts from all eSlate booths, and 
store these printouts in a secure 
location.

2.4.2 Manually recount all VBO “Paper 
Verification Page Reports”, from the 
targeted precinct(s), that include the 
“Ballot Accepted” nomenclature. 

OR Collect this data via reading the 2-D bar 
code on each “Paper Verification Page 
Report” with a 2-D bar code scanner.
If comparing VBO “Paper Verification Page 
Reports” to SERVO reports, note that only 
JBC and/or eSlate device cast vote records 
will include the Ballot Key information to 
reconcile with VBO reports. (eScans do not 
include VBO devices.)

2.4.3 Manually recount Ballot Now and 
eScan paper ballots from the 
targeted precincts, as applicable.

Use a spreadsheet or paper form to keep track 
of votes.

Due to the high likelihood for human error 
using this recount method, the results may 
not match the original Tally reports, or Tally 
or SERVO electronic recounts. 
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3. Contest-Specific Recount
3.1  Tally Contest-Specific Recount

3. Contest-Specific Recount
3.2  SERVO MBB Contest-Specific Recount (via Tally)

Steps: Details:

3.1.1 Perform steps for a full recount with 
Tally.

  See:
  See:“Tally Full Recount” on page 132.

Use the original election MBBs.

3.1.2 Print the “Canvass Report” for the 
contest required.

3.1.3 If necessary, create a custom report 
based on the Precinct Report:

3.1.4 Report Name: “Contest X Recount 
Results”

3.1.5 Based On: Precinct.rpt 
3.1.6 Report Title: “Contest X Recount 

Results”
3.1.7 Select all precincts
3.1.8 Name contest in filter and select 

specific contest
3.1.9 Open and print report
3.1.10 Repeat process with base report of 

Canvass.rpt. Select a new report 
name and title.

Steps: Details:

3.2.1 Perform steps for a Full Recount/
SERVO MBB Recount.

Use SERVO recount MBBs from either the JBCs 
or eSlates.

3.2.2 In Tally, print the “Canvass Report” 
for the contest required.
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3.2.3 If necessary, create a custom report 
based on the Precinct Report:

3.2.4 Report Name: “Contest X Recount 
Results”

3.2.5 Based On: Precinct.rpt 
3.2.6 Report Title: “Contest X Recount 

Results”
3.2.7 Select all precincts
3.2.8 Name contest in filter and select 

specific contest
3.2.9 Open and print report
3.2.10 Repeat process with base report of 

Canvass.rpt. Select a new report 
name and title.

Steps: Details:
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3. Contest-Specific Recount
3.3  SERVO Manual Contest-Specific Recount

Steps: Details:

3.3.1 After the election, back up polling 
place equipment with the SERVO 
application.

Back up eScans, JBCs and eSlates, as 
applicable.

3.3.2 Go to Reports/Votes by Precincts.

3.3.3 Select the Event and Device (type). Print SERVO records for JBCs or eSlates 
only, if also counting eScan paper ballots.
If the election was conducted in Early Voting 
and Election Day modes, perform this 
procedure for each.

3.3.4 Select all precincts. Highlight the first precinct in the list, hold the 
Shift key, and highlight the last precinct in the 
list.

3.3.5 Click OK.

3.3.6 Print the report. For a fully manual recount, highlight the contest 
on each printed CVR and tabulate using a form.

3.3.7 Export the report to a spreadsheet. Example: Excel 5.0 extended

3.3.8 Sort to achieve a format where a 
vote for a candidate in a contest is 
represented per row.

e.g., “President, Abraham Lincoln”

3.3.9 Add a column containing a “1” for 
each row.

e.g., “President, Abraham Lincoln, 1”
This allows Autosum in the next step.

3.3.10 Autosum per candidate in order to 
tabulate the 1’s.

3.3.11 In the spreadsheet, set the print 
area and print a recount report. 
Save as “Recount SERVO Contest 
Election Date”. 

3.3.12 Print to .pdf.

3.3.13 Manually recount Ballot Now and 
eScan paper ballots for the targeted 
contest(s), as applicable.

Use a spreadsheet or paper form to keep track 
of votes.

Due to the high likelihood for human error 
using this recount method, the results may 
not match the original Tally reports, or Tally 
or SERVO electronic recounts. 
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3. Contest-Specific Recount
3.4  VBO and Paper Ballot Manual Contest-Specific Recount

Steps: Details:

3.4.1 After the election, remove VBO 
printouts from all eSlate booths, and 
store these printouts in a secure 
location.

3.4.2 Manually recount all VBO “Paper 
Verification Page Reports”, for the 
targeted contest(s), that include the 
“Ballot Accepted” nomenclature. 

OR Collect this data via reading the 2-D bar 
code on each “Paper Verification Page 
Report” with a 2-D bar code scanner, and 
sort.
If comparing VBO “Paper Verification Page 
Reports” to SERVO reports, note that only 
JBC and/or eSlate device cast vote records 
will include the Ballot Key information to 
reconcile with VBO reports. (eScans do not 
include VBO devices.)

3.4.3 Manually recount Ballot Now and 
eScan paper ballots for the targeted 
contest(s), as applicable.

Use a spreadsheet or paper form to keep track 
of votes.

Due to the high likelihood for human error 
using this recount method, the results may 
not match the original Tally reports, or Tally 
or SERVO electronic recounts. 
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4. Recount of a percentage of the cast ballots or precincts
4.1  Tally Percentage Recount

Steps: Details:

4.1.1 Perform steps for a full recount with 
Tally.

  See:
  See:“Tally Full Recount” on page 132.

Use the original election MBBs.

4.1.2 Use the original Tally reports to 
identify the precinct reports needed 
to fulfill the recount requirements.

The “Precinct Turnout” report gives precinct 
turnout information per contest.
Determine the precincts needed in order to 
meet the required percentage, and any other 
stipulations, for the recount.

4.1.3 Print “Precinct Report” reports for 
the precincts needed to fulfill 
requirements.

4.1.4 If necessary, create a custom report 
based on the “Precinct Report”:

4.1.5 Report Name: “Mandatory Recount 
X Percent Results”

4.1.6 Based On: Precinct.rpt 
4.1.7 Report Title: “Mandatory Recount X 

Percent Results”
4.1.8 Name precinct filter and select 

specific precincts
4.1.9 Select all contest
4.1.10 Open and print report
4.1.11 Repeat process with base report of 

Canvass.rpt. Select a new report 
name and title.
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4. Recount of a percentage of the cast ballots or precincts
4.2  SERVO MBB Percentage Recount (via Tally)

Steps: Details:

4.2.1 Perform steps for a Full Recount/
SERVO MBB Recount.

  See:
  See:“SERVO MBB Full Recount (via Tally)” on 

page 134.

Use SERVO recount MBBs from either the JBCs 
or eSlates.

4.2.2 Use the original Tally reports to 
identify the precinct reports needed 
to fulfill the recount requirements.

The “Precinct Turnout” report gives precinct 
turnout information per contest.
Determine the precincts needed in order to 
meet the required percentage, and any other 
stipulations, for the recount.

4.2.3 In the Tally recount database, print 
“Precinct Report” reports for the 
precincts needed to fulfill 
requirements.

4.2.4 If necessary, create a custom report 
based on the “Precinct Report”:

4.2.5 Report Name: “Mandatory Recount 
X Percent Results”

4.2.6 Based On: Precinct.rpt 
4.2.7 Report Title: “Mandatory Recount X 

Percent Results”
4.2.8 Name precinct filter and select 

specific precincts
4.2.9 Select all contest
4.2.10 Open and print report
4.2.11 Repeat process with base report of 

Canvass.rpt. Select a new report 
name and title.
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4. Recount of a percentage of the cast ballots or precincts
4.3  SERVO Manual Percentage Recount

Steps: Details:

4.3.1 After the election, back up polling 
place equipment with the SERVO 
application.

Back up eScans, JBCs and eSlates, as 
applicable.

4.3.2 Use the original Tally reports to 
identify the precinct reports needed 
to fulfill the recount requirements.

The “Precinct Turnout” report gives precinct 
turnout information per contest.
Determine the precincts needed in order to 
meet the required percentage, and any other 
stipulations, for the recount.

4.3.3 In SERVO, go to Reports/Votes by 
Precincts.

4.3.4 Select the Event, Device (type), 
and Precinct(s).

Print SERVO records for JBCs or eSlates 
only, if also counting eScan paper ballots.
If the election was conducted in Early Voting 
and Election Day modes, you will need to 
perform this procedure for each.
Use the Ctrl key and left mouse click to 
highlight numerous precincts.

4.3.5 Click OK.

4.3.6 Print the report generated. SERVO will also export reports to a spreadsheet 
format with the export tool (envelope icon on 
report menu bar).

  Tip(s):
Excel 5.0 extended is an example that is 
simple to use.

4.3.7 Manually recount Ballot Now and 
eScan paper ballots, as applicable.

Use a spreadsheet or paper form to keep track 
of votes.

Due to the high likelihood for human error 
using this recount method, the results may 
not match the original Tally reports, or Tally 
or SERVO electronic recounts. 
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4. Recount of a percentage of the cast ballots or precincts
4.4  VBO and Paper Ballot Manual Percentage Recount

Steps: Details:

4.4.1 After the election, remove VBO 
printouts from all eSlate booths, and 
store these printouts in a secure 
location.

Back up eScans, JBCs and eSlates, as 
applicable.

4.4.2 Use the original Tally reports to 
identify the precinct reports needed 
to fulfill the recount requirements.

The “Precinct Turnout” report gives precinct 
turnout information per contest.
Determine the precincts needed in order to 
meet the required percentage, and any other 
stipulations, for the recount.

4.4.3 Manually recount all VBO “Paper 
Verification Page Reports”, for the 
targeted precinct(s), that include the 
“Ballot Accepted” nomenclature. 

OR Collect this data via reading the 2-D bar 
code on each “Paper Verification Page 
Report” with a 2-D bar code scanner, and 
sort.
If comparing VBO “Paper Verification Page 
Reports” to SERVO reports, note that only 
JBC and/or eSlate device cast vote records 
will include the Ballot Key information to 
reconcile with VBO reports. (eScans do not 
include VBO devices.)

4.4.4 Manually recount Ballot Now and 
eScan paper ballots for the targeted 
precinct(s), as applicable.

Use a spreadsheet or paper form to keep track 
of votes.

Due to the high likelihood for human error 
using this recount method, the results may 
not match the original Tally reports, or Tally 
or SERVO electronic recounts. 
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5. Recount of a Polling Place
5.1  Tally Polling Place Recount

Steps: Details:

5.1.1 If precinct report level recount is 
required for a select group of polling 
places, perform steps for a full 
recount with Tally, but only process 
those MBBs from the polling 
place(s) in question.

Use the original election MBBs from selected 
polling places.

5.1.2 Print “Precinct Report” reports for 
the precincts needed to fulfill 
requirements.

5.1.3 If individual reports are needed per 
polling place:

5.1.4 Create a new Tally Database, as in 
procedures for a full recount. Name 
the Tally Database “RECOUNT 
Polling Place <X>  <Election Name 
Date>”

5.1.5 Read MBB(s) in for the polling 
places involved in the recount

5.1.6 Finalize the database.
5.1.7 Create a custom report based on 

the “Precinct Report”:
5.1.8 Report Name: “Polling Place X 

Results”
5.1.9 Based On: Precinct.rpt
5.1.10 Report Title: “Polling Place X 

Results”
5.1.11 Name the precinct filter according to 

the polling place and select 
precincts assigned to that polling 
place

5.1.12 Select all contests
5.1.13 Open and print report.
5.1.14 Repeat reporting process for each 

target polling place.
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5. Recount of a Polling Place
5.2  SERVO MBB Polling Place Recount

Steps: Details:

5.2.1 Perform steps for a Full Recount/
SERVO MBB Recount.

  See:
  See:“SERVO MBB Full Recount (via Tally)” on 

page 134.

Use SERVO recount MBBs from either the JBCs 
or eSlates.

5.2.2 In Tally, print the “Precinct Report” 
for all precincts assigned to the 
target polling place.

5.2.3 If necessary, create a custom report 
based on the Precinct Report:

5.2.4 Report Name: “Polling Place X 
Results”

5.2.5 Based On: Precinct.rpt
5.2.6 Report Title: “Polling Place X 

Results”
5.2.7 Name polling place in precinct filter 

and select precincts assigned to 
polling place

5.2.8 Select all contests
5.2.9 Open and print report
5.2.10 Repeat process for each target 

polling place.
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5. Recount of a Polling Place
5.3  SERVO Manual Polling Place Recount

Steps: Details:

5.3.1 After the election, back up polling 
place equipment with the SERVO 
application.

Back up eScans, JBCs and eSlates, as 
applicable.

5.3.2 In SERVO, go to Reports/Votes by 
Precincts.

5.3.3 Select the Event, Device (type), 
and the Precinct(s) that were 
assigned to the target polling place.

Print SERVO records for JBCs or eSlates 
only, if also counting eScan paper ballots.
Use the Ctrl key and click to highlight 
numerous precincts.

5.3.4 Click OK.

5.3.5 Print the report generated. SERVO will also export reports to a spreadsheet 
format with the export tool (envelope icon on 
report menu bar).

  Tip(s):
The Excel 5.0 extended export is a 
format that is simple to use.

5.3.6 Manually recount Ballot Now and 
eScan paper ballots from the target 
polling place(s), as applicable.

Use a spreadsheet or paper form to keep track 
of votes.

Due to the high likelihood for human error 
using this recount method, the results may 
not match the original Tally reports, or Tally 
or SERVO electronic recounts. 
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5. Recount of a Polling Place
5.4  VBO and Paper Ballot Manual Polling Place Recount

Steps: Details:

5.4.1 After the election, remove VBO 
printouts from all eSlate booths, and 
store these printouts in a secure 
location.

5.4.2 Manually recount all VBO “Paper 
Verification Page Reports”, for 
equipment from the targeted polling 
place(s), that include the “Ballot 
Accepted” nomenclature. 

OR Collect this data via reading the 2-D bar 
code on each “Paper Verification Page 
Report” from the targeted polling place(s) 
with a 2-D bar code scanner.
If comparing VBO “Paper Verification Page 
Reports” to SERVO reports, note that only 
JBC and/or eSlate device cast vote records 
will include the Ballot Key information to 
reconcile with VBO reports. (eScans do not 
include VBO devices.)

5.4.3 Manually recount Ballot Now and 
eScan paper ballots for the targeted 
polling place(s), as applicable.

Use a spreadsheet or paper form to keep track 
of votes.

Due to the high likelihood for human error 
using this recount method, the results may 
not match the original Tally reports, or Tally 
or SERVO electronic recounts. 
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Appendix H: Restoring a Tally Database to a Previous State
A Tally database can be restored to a previous state if the database has been backed up while in that 
previous state. 

Only advanced PC and HVS users should restore a Tally database. Restoring a Tally database 
overwrites the active Tally database with a Tally database from the backup folder. Follow proper 
database management procedures in order to protect the integrity of the election during this 
process. 

  See:
  See:“Tally Database Management” on page 9.

Steps: Details:

1. At any point in the tabulation process, 
click the Election Information Quick Link 
and click Backup.

Back up to a folder identified with the Function 
(Backup) Election Date and the Current Time.

2. Continue with tabulation operations.

3. Click the Election Information Quick 
Link, click Restore, and follow prompts to 
navigate to the backup folder, and to the 
TallyData.db file.

The election currently running will restore to the 
status of the backup database.

This action overwrites the Tally database 
currently active with the Tally database from 
the backup folder.

4. Continue with tabulation operations.
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Notes:
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Appendix I: Importing Data

Data For Import

The Tally Import Wizard guides the user through importing files. Tally accepts comma-delimited ASCII 
text files that may, or may not, surround fields with single quotation marks, and that must contain header 
information. Several types of data can be imported into the active Tally election database (from a voter 
registration system, for example):

District layers for use in building custom reports
Provisional ballot status updates
Registered voters per precinct and/or party numbers updates
Retrievable ballot status updates

  Tip(s):
Back up the Tally database before performing imports. This will preserve the pre-import 
tabulation data.

  See:
  See:The Tally Operations Manual for more information about importing data into Tally.

Import File Formats

District Layer Import File Format

The district layer defines a district name with a group of associated precinct/splits. This same function 
exists in Tally via the Report Wizard without importing new district associations, simply by defining a new 
precinct group filter.

Each District Title can be between 1 and 100 characters.
The precinct/split names must match precinct/split names currently in the Tally database.
Split name is optional. If split names are not specified, all splits associated with the precinct will be 
included in the district.
The import file can contain multiple district layers.

Field Name: Type: Description:

District Title Char (100) Name of the District

Precinct Name Char (100) Precinct Name

Split Name Char (100) Optional Split Name
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Provisional Ballot Status Import File Format

Provisional ballots can be identified as included/accepted or excluded/rejected, and can be parsed by 
precinct and/or party via data import. This feature allows data exports from a voter registration system, 
where provisional voters have already been resolved, to be imported into Tally in order to mirror that 
resolution without doing so manually.

The Ballot ID must match a provisional Ballot Code in the Tally database.
The Ballot ID and Ballot State fields are required. The other fields are optional, and can be left blank.
Provisional parsing requires the use of the precinct/split field(s). These must match precincts/splits 
defined in the Tally database.
Provisional parsing by party requires the use of the Ballot Party Code field for a closed primary and 
the Voter Party Code for a modified closed primary. These must match precincts/splits defined in the 
Tally database.
In general and special elections, Tally ignores the party fields.
The first line of the import file specifies the column headers.

Field Name: Type: Description:

Ballot ID Number The Ballot Code

Ballot State
Char(1) E = Exclude ballot from count

I = Include ballot in count

Precinct Name
String Precinct to be associated with 

the ballot (thus defining 
contests counted)

Split Name
String The split to be associated with 

the ballot (thus further defining 
contests counted)

Ballot Party Code

String The party ballot type associated 
with the ballot (thus further 
defining contests counted for a 
closed primary)

Voter Party Code

String The party voter type associated 
with the ballot (thus further 
defining contests counted for a 
modified closed primary)
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Registered Voters Import File Format

Tally allows for an import updating the number of registered voters in the precincts defined in the 
election. This import may come from an export from a voter registration system or another source that 
creates the comma-delimited ASCII text file.

The precinct/split names must match 
precinct/split names currently in the 
Tally database.
Only the precincts/splits listed in the 
import file will be updated.

Retrievable Ballot Status Import File 
Format

Retrievable ballots can be identified as included/accepted or excluded/rejected via data import. This 
feature allows for data exports from a voter registration system, where retrievable ballots for early voters 
have already been resolved, to be imported into Tally in order to mirror that resolution without doing so 
manually.

The Ballot ID must match a provisional Ballot Code in the 
Tally database.
The Ballot ID and Ballot State fields are required.
The first line of the import file specifies the column headers.

Field Name: Type: Description:

Registered Voters Integer Number of registered voters in the precinct/split

Precinct Name Char(100) Name of the precinct in the election

Split Name Char(100) Name of split, if applicable

Party Code
Char(50) The code for the associated party, if a primary 

election

Field Name: Type: Description:

Ballot ID Char(10) The Ballot Code

Ballot State
Char(1) E = Exclude ballot from count

I = Include ballot in count
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Using the Tally Import Wizard

The following is one example of the Tally Import Wizard. Windows will vary per import type.

1. To access the Import Wizard, go to the File menu and click Import.

2. Click Next.

3. Select the import type and click Next.
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4. Depending on the import type, use available buttons to identify import options, and click the 
Browse button to navigate to the file you want to import.

5. Highlight the file you want to import and click Open.
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6. The filepath to the import file appears in the Name of file to import field. Click Next.

7. The Import Wizard will verify that the data is being read, and it will display any error or alert 
messages if there are problems with the import file. Correct errors if necessary and click Next.
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8. The Import Wizard verifies that data is saved to the database, and that the import process is 
completed. Click Next and then click Close.

9. Verify imported data by viewing the Tally windows and reports.
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Notes:
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Appendix J: Exporting Data

Data for Export

The Tally Export Wizard guides the user through exporting files. Tally exports tab-delimited and comma-
delimited ASCII text files and EDX files. Several types of data can be exported from the Tally election 
database:

Landscape Vote Totals - aggregated vote totals in a landscape .txt format
EDX - Election Data eXchange XML format for integration with other systems
Detail Vote Totals - filtered for Absentee, Early Voting, and/or Election Day results
Provisional Ballot Status - suitable for export, update, and import
Retrievable Ballot Status - suitable for export, update, and import
Registered Voters - registered voter data in .csv format

  Note:
When creating Registered Voters export files for primary elections, select the Export By Party 
checkbox so the vote totals can be re-imported.

  See:
  See:The Tally Operations Manual for more information about exporting Tally data.

Export File Types

Landscape (Aggregated) Vote Totals

The landscape aggregated vote totals option exports all data in the database in a tab-delimited text file 
format. 

EDX

EDX exports all data in the database in an Election Data eXchange XML file format.
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Detail Vote Totals

The Detail Vote Totals option exports the vote totals from each precinct from the Tally database into 
comma-separated-values files which may be exported in detailed types via filters in the export wizard. 
Detail types include:

Total (Absentee results, Early Voting results, Election Day results)
Early (Early Voting results only)
Election (Election Day results only)

Filters are applied to the detailed export types, allowing the user to combine Early and Absentee results 
in the Total export, and to include or exclude over and under votes in any of the detail exports.

  See:
  See:The Tally Operations Manual for a definition of fields in the Detail Vote Totals export file.

Provisional Ballot Status

The Provisional Ballot Status export file can be used to verify data in an associated voter registration 
system, for example. This file can be exported, modified, and imported to update provisional ballot 
status. The first row of the file lists the column headers. The file includes the following data fields in a 
comma-separated-values format:

Ballot Code
Ballot State (“E” = exclude from results, “I” = include in results)
Precinct Name
Split Precinct Name
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Retrievable Ballot Status

The Retrievable Ballot Status export file can be used to verify early voting retrievable ballot data in an 
associated voter registration system, for example. This file can be exported, modified, and imported to 
update retrievable ballot status. The first row of the file lists the column headers. The file includes the 
following data fields in a comma-separated-values format:

Ballot Code
Ballot State (“E” = exclude from results, “I” = include in results)

Registered Voters

The Registered Voters export file can be used to export registered voter data. The first row of the file lists 
the column headers. The file includes the following data fields in a comma-separated-values format:

Registered Voters
Precinct Name
Split Precinct Name
Party Code (Optional) 
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Using the Export Wizard

The following is one example of the Tally Export Wizard. Windows will vary per export type.

1. To access the Export Wizard, go to the File menu and click Export.

2. Click Next.

3. Select the export type and click Next.
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4. Select export options, as available, and click Browse to navigate to the location for the file.

5. Name the file and click Open.
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6. The filepath to the target file appears in the Name of file to import field. Select the Next button.

7. The Export Wizard writes the data file, and displays any warning messages. Select the Back, 
Next, or Cancel button as directed by the wizard. If the export is successful, the Export Wizard 
will continue by default. 
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8. The export process is complete. Select the Close button.

9. Navigate to the exported file and verify that the expected data was exported.
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Notes:
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Appendix K: Tally Operator Steps Checklist
These are the steps for tabulating an election with the Tally application only (without Tally-Rally 
communications).

Tally Operator Steps:

1. In the BOSS program, finalize the BOSS database for Tally.

2. Double-click the Tally desktop shortcut to open the application.

3. Log in to Tally as a user with Administrator permissions.

4. If you haven’t already done so, set up Tally users and permission levels.

5. Create and name/describe a new Test or Election mode database in Tally by copying the 
finalized BOSS database or importing an existing Tally database from file.

6. Highlight the target database, and click Select to open it.

7. Set the Tally reporting options for report labeling, candidate cross-filing, and write-in 
reporting.

8. (Optional) Change the ballot source labels that appear on reports.

9. (Optional) Define write-in candidates and aliases, if applicable.

10. Create a Tally Zero Report (“Cumulative Report”).

10.1  Select report options available, click OK, and view the report.

11. If you haven’t already done so, insert the eCM into a USB port.

12. Process MBBs.

13. Print reports.

14. For risk-reduction and archival purposes, back up the Tally database to a time-stamped 
folder.

15. Process Early Voting Retrievable ballots, if applicable (or import retrievable data).

16. Include or confirm exclusion of provisional ballots, if applicable (or import provisional 
data).

17. Parse provisional ballots, if applicable (or import provisional data).

18. Print the “Ballot Status” report for provisional ballots, if applicable.

19. Resolve votes for write-in candidates, if applicable.

19.1  Resolve write-in votes from the eSlate and Ballot Now.

19.2  Resolve write-in images and votes from the eScan.

20. Calculate vote adjustments, if applicable.

21. For risk-reduction and archival purposes, back up the Tally database to a time-stamped 
folder before finalizing.
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22. After all MBBs have been processed, finalize the election in Tally.

23. Print standard reports.

24. Create and print custom reports by clicking the Tally Report Wizard button in the 
Reporting window.

25. For risk-reduction and archival purposes, back up the Tally database to a time-stamped 
folder.

26. Import data, if necessary.

27. If data was imported, repeat reporting and database backup steps.

28. Export data, if necessary.

29. Exit Tally.

Tally Operator Steps:
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Appendix L: Tally-Rally Integrated Steps Checklist
These are the steps for tabulating an election with the Tally application, with some election data coming 
from communications with Rally.

Tally-Rally Integrated Steps:

Part 1: Tally and Rally Configuration

1. In the BOSS program, finalize the BOSS database for Tally.

2. Physically set up Tally and Rally PC hardware and Windows LAN and/or modem 
configurations.

3. Double-click the Tally desktop shortcut to open the application.

4. Log in to Tally as a user with Administrator permissions.

5. If you haven’t already done so, set up Tally users and permission levels.

6. Create and name/describe a new Test or Election mode database in Tally by copying the 
finalized BOSS database or importing an existing Tally database from file.

7. Highlight the target database, and click Select to open it.

8. Set the Tally reporting options for report labeling, candidate cross-filing, and write-in 
reporting.

9. (Optional) Change the ballot source labels that appear on reports.

10. (Optional) In Tally, define write-in candidates and aliases, if applicable.

11. In Tally, verify and enable Rally Configuration options for LAN and/or modem 
connections.

12. In Tally, verify certificate information.

13. Exit Tally (optional).

14. At each Rally station, open the Rally application and log in as a user with all permissions.

15. In Rally, reset the database, and then enter the station name as defined in Tally’s Rally 
Configuration window.

16. In Rally, at stations connecting to Tally via modem, verify dial-in options.

17. In Rally, if you haven’t already done so, set up the Rally station operator as a user with at 
least Information archiving, MBB processing/transferring, and Reporting 
permissions.

18. In Rally, if you haven’t already done so, set up the election event Tally operator as a user 
with at least MBB processing/transferring permissions.

19. In Rally, verify certificate information.

20. Exit Rally.
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Part 2: Election Day Tally-Rally Sequential Steps

1. Log in to Tally as the election operator and select the target election.

2. Create a Tally “Zero Report”.

2.1  Select report options available, click OK, and view the report.

3. If you haven’t already done so, insert the eCM into a USB port.

4. Process Absentee and Early Voting MBBs.

5. Print reports.

6. For risk-reduction and archival purposes, back up the Tally database to a time-stamped 
folder.

7. At each Rally station, operator-level users log in.

8. In Rally, print “Zero Reports”.

9. In Tally, enable Rally stations and start remote transfer.

10. In Tally, process Election Day MBBs.

11. In Rally, process Election Day MBBs.

12. In Tally, the first connection with each Rally PC includes accepting a security certificate 
from Rally. Verify, and then click Yes to accept this certificate.

13. In Rally, the first connection with the Tally PC includes accepting a security certificate 
from Tally. Verify and click Yes to accept this certificate.

14. In Tally, verify that accepted Rally stations display “Yes” in the Trusted field of the Rally 
Configuration window.

15. In Tally, print reports.

16. For risk-reduction and archival purposes, back up the Tally database to a time-stamped 
folder.

17. In Rally, print reports.

18. In Tally, consult reports to verify that all expected Rally station MBB data has been 
received.

19. Exit Rally.

20. From each Rally station, transport processed MBBs and Rally reports to the counting 
station.

21. In Tally, after processing all MBBs, process Early Voting Retrievable ballots, if applicable 
(or import retrievable data).

22. Include or confirm exclusion of provisional ballots, if applicable (or import provisional 
data).

Tally-Rally Integrated Steps:
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23. Parse provisional ballots, if applicable (or import provisional data).

24. Print the “Ballot Status” report for provisional ballots, if applicable.

25. Resolve votes for write-in candidates, if applicable.

25.1  Resolve write-in votes from the eSlate and Ballot Now.

25.2  Resolve write-in images and votes from the eScan.

26. Calculate vote adjustments, if applicable.

27. For risk-reduction and archival purposes, back up the Tally database to a time-stamped 
folder before finalizing.

28. After all MBBs have been processed, finalize the election in Tally.

29. Print standard reports.

30. Create and print custom reports by clicking the Tally Report Wizard button in the 
Reporting window.

31. For risk-reduction and archival purposes, back up the Tally database to a time-stamped 
folder.

32. Import data, if necessary.

33. If data was imported, repeat reporting and database backup steps.

34. Export data, if necessary.

35. Exit Tally.

Tally-Rally Integrated Steps:
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Notes:
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Appendix M: Best Practices for Tally-Rally Setup

LAN Setup Modem Setup

Rally PC, Station Name, and operator User 
ID SHOULD be unique.

Rally PC, Station Name, and operator User 
ID SHOULD be unique.

All IP addresses MUST be unique. Rally PC modems SHOULD be set up to 
share the same IP address.

The election event Tally operator MUST be 
set up in Rally as a user with at least MBB 
transferring/processing permissions.

The election event Tally operator MUST be 
set up in Rally as a user with at least MBB 
transferring/processing permissions.

The election event Rally operator SHOULD 
be set up in Rally as user with Information 
archiving, MBB processing/transferring, 
and Reporting permissions.

The election event Rally operator SHOULD 
be set up in Rally as user with Information 
archiving, MBB processing/transferring, 
and Reporting permissions.

Test all Tally-Rally connections before a live 
election event. Data does not need to be 
transferred in order to test connections.

The election event Tally operator User ID and 
Password SHOULD be entered in both 
Tally’s Rally Configuration window and 
Rally’s Dial-in Access tab (Modem Name 
and Modem Password).

(OR A separate and unique Modem Name 
and Modem Password MUST be entered in 
both Tally’s Rally Configuration window and 
Rally’s Dial-in Access tab.)

All Rally stations using modem connections 
MUST use the same Modem Name and 
Modem Password for an election.

The Tally PC modem and Rally PC modem 
connections MUST be configured to the same 
maximum speed (e.g., 115200 bps).

Test all Tally-Rally connections before a live 
election event. Data does not need to be 
transferred in order to test connections.
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Notes:






	Training Manual
	Table of Contents
	Getting Started
	Introduction
	What is Tally?
	What is Rally?
	This Document
	Tally Operator Course Objectives

	Hart Voting System Data Flowchart
	Hart Voting System Security Features
	Tally Windows
	Tally Menus
	Maximum Number of Characters for Fields in Tally
	Tally Database Management
	Database Naming Conventions
	Function of the Database
	Sequence Number
	Election Description

	Database Status
	Database Mode
	Testing
	Database File Path
	Backing up a Tally Database
	Deleting a Tally Database

	Rally Database Management
	Tally Overview
	Tally Install Settings
	Pre-Tally Activities
	Pre-Election Day Activities
	Election Day Activities
	Post-Election Day Activities

	Tally User Permissions and Certificate
	First Login After Installation of Tally
	Creating Additional Users
	Updating Certificate Information
	Tally User Permissions

	Setting Up Tally’s Real-Time Audit Log
	Tally Tasks Requiring the eSlate Cryptographic Module (eCM)
	What is the eCM?
	When is the eCM Used?
	eCM Management


	Using Tally to Count Voted MBBs
	Logic and Accuracy Testing Procedures
	Logic and Accuracy Test Prerequisites
	Materials
	eSlate System Logic and Accuracy Test Procedure
	Step 1: Vote Test Deck Paper Ballots
	Step 2: Tally Zero Report
	Step 3: JBC Zero Report
	Step 4: Cast Matching Votes on the eSlate
	Step 5: Scan Test Deck in Ballot Now
	Step 6: Tabulate MBBs and Print Tally Reports
	Step 7: Document Logic and Accuracy Test

	eScan System Logic and Accuracy Test Procedure
	Step 1: Print and Vote Test Deck Paper Ballots
	Step 2: Tally Zero Report
	Step 3: eScan Zero Report
	Step 4: Scan Test Deck on the eScan
	Step 5: Scan Test Deck in Ballot Now
	Step 6: Tabulate MBBs and Print Tally Reports
	Step 7: Document Logic and Accuracy Test

	eScan Embedded Logic and Accuracy Test Procedure
	Logic and Accuracy Test Documentation
	Logic and Accuracy Test Envelope Labels

	Coordinating Definitions in Tally and Rally
	Part 1: Establish User IDs and Permissions
	Tally Settings
	Rally Settings

	Part 2: Update Certificates
	Tally Settings
	Rally Settings

	Part 3: Set Up Rally Station Information
	Tally Settings
	Rally Settings

	Part 4: Configure Dial-In Access (if applicable)
	Tally Settings
	Rally Settings


	Using Tally-Rally to Count Voted MBBs
	Part 1: Tally and Rally Configuration
	Part 2: Election Day Tally-Rally Steps

	Tally-Rally Troubleshooting
	Connection from Tally is repeatedly unsuccessful
	Connection from Tally is repeatedly unsuccessful
	Connection from Tally initially successful, but then interrupted and lost
	Login to Rally unsuccessful
	MBBs are not reading into Rally
	Rally displays an MBB information message
	Rally displays a printer error message
	Rally displays an eCM warning message

	Appendices
	Appendix A: Glossary
	Appendix B: Information, Confirmation, Error, and Warning Messages
	Appendix C: Hart Voting System Software User Tips
	Software Password, Certificate, and PIN Tips
	Computer Security
	Software Features
	The following tips apply to specific software programs:


	Appendix D: Backing Up Election Databases
	What Data to Back Up
	How and When to Back Up Data
	Backing up to CD

	Appendix E: Windows Tally and Rally LAN Setup
	Appendix F: Windows Tally and Rally Modem Setup
	Modem Setup Part 1: At the Tally PC Using a Modem
	Modem Setup Part 2: At each Rally PC Using a Modem

	Appendix G: Hart Voting System Recount Procedures
	Appendix H: Restoring a Tally Database to a Previous State
	Appendix I: Importing Data
	Data For Import
	Import File Formats
	District Layer Import File Format
	Provisional Ballot Status Import File Format
	Registered Voters Import File Format
	Retrievable Ballot Status Import File Format

	Using the Tally Import Wizard

	Appendix J: Exporting Data
	Data for Export
	Export File Types
	Landscape (Aggregated) Vote Totals
	EDX
	Detail Vote Totals
	Provisional Ballot Status
	Retrievable Ballot Status
	Registered Voters

	Using the Export Wizard

	Appendix K: Tally Operator Steps Checklist
	Appendix L: Tally-Rally Integrated Steps Checklist
	Appendix M: Best Practices for Tally-Rally Setup


